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This is the hardware warranty.

Warranty

Tektronix warrants that the product will be free from defects in materials and workmanship for a period of three (3)
years from the date of original purchase from an authorized Tektronix distributor. If the product proves defective
during this warranty period, Tektronix, at its option, either will repair the defective product without charge for
parts and labor, or will provide a replacement in exchange for the defective product. Batteries are excluded from
this warranty. Parts, modules and replacement products used by Tektronix for warranty work may be new or
reconditioned to like new performance. All replaced parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period and make suitable arrangements for the performance of service. Customer shall be
responsible for packaging and shipping the defective product to the service center designated by Tektronix,
shipping charges prepaid, and with a copy of customer proof of purchase. Tektronix shall pay for the return of the
product to Customer if the shipment is to a location within the country in which the Tektronix service center is
located. Customer shall be responsible for paying all shipping charges, duties, taxes, and any other charges for
products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate
maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage
resulting from attempts by personnel other than Tektronix representatives to install, repair or service the product;
b) to repair damage resulting from improper use or connection to incompatible equipment; c) to repair any damage
or malfunction caused by the use of non-Tektronix supplies; or d) to service a product that has been modified or
integrated with other products when the effect of such modification or integration increases the time or difficulty
of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE

AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.
TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS
ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.

[W16 — 15AUG04]



This is the software warranty.

Warranty

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on
the media will be free from defects in materials and workmanship for a period of three (3) months from the date of
shipment. If any such medium or encoding proves defective during the warranty period, Tektronix will provide

a replacement in exchange for the defective medium. Except as to the media on which this software product is
furnished, this software product is provided “as is” without warranty of any kind, either express or implied.
Tektronix does not warrant that the functions contained in this software product will meet Customer's requirements
or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and
workmanship within a reasonable time thereafter, Customer may terminate the license for this software product
and return this software product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX' RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER'S
PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH
OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX
OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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Important safety and compliance information

Important safety information

This manual contains information and warnings that must be followed by the user for safe
operation and to keep the product in a safe condition. To safely perform service on this
product, additional information is provided at the end of this section. (See Service safety
summary.)

General safety summary

TekSmartLab User Manual

Use the product only as specified. Review the following safety precautions to avoid injury
and prevent damage to this product or any products connected to it. Carefully read all
instructions. Retain these instructions for future reference.

Comply with local and national safety codes.

For correct and safe operation of the product, it is essential that you follow generally
accepted safety procedures in addition to the safety precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover
for repair, maintenance, or adjustment.

This product is not intended for detection of hazardous voltages.

While using this product, you may need to access other parts of a larger system. Read the
safety sections of the other component manuals for warnings and cautions related to
operating the system.

When incorporating this equipment into a system, the safety of that system is the
responsibility of the assembler of the system.

To avoid fire or personal injury

Use proper power cord. Use only the power cord specified for this product and certified
for the country of use.

Do not use the provided power cord for other products.

Ground the product. This product is grounded through the grounding conductor of the
power cord. To avoid electric shock, the grounding conductor must be connected to earth
ground. Before making connections to the input or output terminals of the product, make
sure that the product is properly grounded.

Power disconnect. The power cord disconnects the product from the power source. See
instructions for the location. Do not position the equipment so that it is difficult to operate
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vi

the power cord; it must remain accessible to the user at all times to allow for quick
disconnection if needed.

Use proper AC adapter. Use only the AC adapter specified for this product.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and
markings on the product. Consult the product manual for further ratings information before
making connections to the product.

The measuring terminals on this product are not rated for connection to mains or
Category I, lIl, or IV circuits.

Do not operate without covers. Do not operate this product with covers or panels
removed, or with the case open. Hazardous voltage exposure is possible.

Avoid exposed circuitry. Do not touch exposed connections and components when
power is present.

Do not operate with suspected failures. If you suspect that there is damage to this
product, have it inspected by qualified service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates
incorrectly. If in doubt about safety of the product, turn it off and disconnect the power
cord. Clearly mark the product to prevent its further operation.

Examine the exterior of the product before you use it. Look for cracks or missing pieces.
Use only specified replacement parts.

Do not operate in wet/damp conditions. Be aware that condensation may occur if a
unit is moved from a cold to a warm environment.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean the
product.

Provide a safe working environment. Always place the product in a location convenient
for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or
prolonged keyboard or pointer use may result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an
ergonomics professional to avoid stress injuries.

TekSmartLab User Manual
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Service safety summary

TekSmartLab User Manual

The Service safety summary section contains additional information required to safely
perform service on the product. Only qualified personnel should perform service
procedures. Read this Service safety summary and the General safety summary before
performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this product
unless another person capable of rendering first aid and resuscitation is present.

Disconnect power. To avoid electric shock, switch off the product power and disconnect
the power cord from the mains power before removing any covers or panels, or opening
the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist in
this product. Disconnect power, remove battery (if applicable), and disconnect test leads
before removing protective panels, soldering, or replacing components.

Terms in this manual

These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could
result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could
result in damage to this product or other property.

Symbols and terms on the product
These terms may appear on the product:

¥  DANGER indicates an injury hazard immediately accessible as you read the
marking.

¥ WARNING indicates an injury hazard not immediately accessible as you read the
marking.

®  CAUTION indicates a hazard to property including the product.
When this symbol is marked on the product, be sure to consult the manual to find
out the nature of the potential hazards and any actions which have to be taken to

avoid them. (This symbol may also be used to refer the user to ratings in the
manual.)

vii
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The following symbol(s) may appear on the product:

A\

Caution
Refer to Manual

Compliance information

EMC compliance

viii

This section lists the EMC (electromagnetic compliance), safety, and environmental
standards with which the instrument complies.

EC Declaration of Conformity - EMC

Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility. Compliance was
demonstrated to the following specifications as listed in the Official Journal of the
European Communities:

EN 61326-1 2006. EMC requirements for electrical equipment for measurement, control,
and laboratory use.' 23

CISPR 11:2003. Radiated and conducted emissions, Group 1, Class A
IEC 61000-4-2:2001. Electrostatic discharge immunity

|EC 61000-4-3:2002. RF electromagnetic field immunity

|EC 61000-4-4:2004. Electrical fast transient / burst immunity

|EC 61000-4-5:2001. Power line surge immunity

IEC 61000-4-6:2003. Conducted RF immunity

' This product is intended for use in nonresidential areas only. Use in residential areas may cause
electromagnetic interference.

2 Emissions which exceed the levels required by this standard may occur when this equipment is
connected to a test object.

3 For compliance with the EMC standards listed here, high quality shielded interface cables should
be used.

TekSmartLab User Manual
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Safety compliance

TekSmartLab User Manual

¥ |EC 61000-4-11:2004. Voltage dips and interruptions immunity
EN 61000-3-2:2006. AC power line harmonic emissions

EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker
European contact.

Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

Australia / New Zealand Declaration of Conformity - EMC

Complies with the EMC provision of the Radiocommunications Act per the following
standard, in accordance with ACMA:

®  CISPR 11:2003. Radiated and Conducted Emissions, Group 1, Class A, in
accordance with EN 61326-1:2006.

Australia / New Zealand contact.

Baker & McKenzie

Level 27, AMP Centre

50 Bridge Street

Sydney NSW 2000, Australia

This section lists other safety compliance information.
Equipment type

Test and measuring equipment.

Pollution degree descriptions

A measure of the contaminants that could occur in the environment around and within a
product. Typically the internal environment inside a product is considered to be the same
as the external. Products should be used only in the environment for which they are rated.

¥ Pollution degree 1. No pollution or only dry, nonconductive pollution occurs.
Products in this category are generally encapsulated, hermetically sealed, or located
in clean rooms.

¥ Pollution degree 2. Normally only dry, nonconductive pollution occurs. Occasionally
a temporary conductivity that is caused by condensation must be expected. This
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location is a typical office/home environment. Temporary condensation occurs only
when the product is out of service.

¥ Pollution degree 3. Conductive pollution, or dry, nonconductive pollution that
becomes conductive due to condensation. These are sheltered locations where
neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

¥ Pollution degree 4. Pollution that generates persistent conductivity through
conductive dust, rain, or snow. Typical outdoor locations.

Pollution degree rating

Pollution degree 2 (as defined in IEC 61010-1). Rated for indoor, dry location use only.

Environmental considerations
This section provides information about the environmental impact of the product.

Product end-of-life handling
Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and use of
natural resources. The equipment may contain substances that could be harmful to the
environment or human health if improperly handled at the product’'s end of life. To avoid
release of such substances into the environment and to reduce the use of natural
resources, we encourage you to recycle this product in an appropriate system that will
ensure that most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European

Union requirements according to Directives 2002/96/EC and 2006/66/EC  on
waste electrical and electronic equipment (WEEE) and batteries. For
information about recycling options, check the Support/Service section of
theTektronix Web site (www.tektronix.com).

Restriction of hazardous substances

This product is classified as an industrial monitoring and control instrument accessory,
and is not required to comply with the substance restrictions of the recast RoHS Directive
2011/65/EU until July 22, 2017.

X TekSmartLab User Manual



TBX3000A

Overview

This guide introduces the TBX3000A and provides a step by step demonstration of how to
use the product.

Packing list
Please confirm that you have received all the items listed in the packing list:
" The TBX3000A
® 4 USB cables
® 1 power cable

® 1 DC power adaptor

Get Acquainted with TBX3000A

Main features

TBX3000A is used to connect Tektronix and Keithley products: oscilloscope, signal
generator, digital multimeter, and power supply.

" ltis equipped with USB 2.0 ports and RJ45 10/100Mbps Ethernet port
¥ It can be connected to WIFI after installing a USB WIFI dongle

¥ ltis powered by a DC power adaptor (5V/3A)

TekSmartLab™ TBX3000A, TSL3000B User Manual 1
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Appearance

-

AL M O J=ndt

DEVICE RESET

f — P —

Figure 1: Side view 1 of TBX3000A
One side of TBX3000A has the following connectors, buttons, and indicators:
¥ Ethernet LAN port: The TBX3000A is connected to the network through this port.

¥ USB device port: The original code of the product is burned through this port, which
is used by manufacturer only.

¥ Reset button: If you press this button and hold down to 5 seconds, the SYS indicator
will blink rapidly for 5 seconds, then the default setting (including password and IP
parameters) will be restored.

" DC power socket: Use this connector for the DC power supply that came with your
instrument.

-\

Figure 2: Side view 2 of TBX3000A

The figure above shows another side of TBX3000A with six USB 2.0 ports. You can
connect TBX3000A to other instruments by USB cable.

2 TekSmartLab User Manual
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The figure below is the top view of TBX3000A, showing the Tektronix logo and indicators.

Figure 3: Top view of TBX3000A

7 )

e TS hRGINX
/

= [ S R S S e s ¢ o
k 1 2 3 4 5 [ i sys J
I I

¥ The first six are USB indicators. If the indicator is on or blinking, it means some
instrument is connected to TBX3000A through a USB port.

®  The one next to the USB indicators is the WIFI indicator:

o Ifit's noton, it means the USB WIFI dongle is not installed or the WIFI dongle is
not compatible with the instrument.

o Ifitblinks once at a time, it means the USB WIFI dongle is installed, but
TBX3000A is not connected to the WIFI.

o [fit blinks twice at a time, it means the USB WIFI dongle is installed, and
TBX3000A is connected to the WIFI.

¥ The last indicator is the system indicator (SYS):
o [fit blinks rhythmically, it means the power is on and the system is functioning.
o [fit's not on, it means the power is not on or the system is malfunctioning.

o [fit blinks unrhythmically, it means the firmware is upgrading.

TekSmartLab User Manual 3
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The figure below shows the bottom aspect of TBX3000A.

Figure 4: Bottom view of TBX3000A

The partillustrated as 7 is a socket for USB WIFI dongle like Netgear WNA1000M.

Configure the TBX3000A

When the TBX3000A is connected to the network, you can configure instrument
parameters. The default IP address for the instrument is 192.168.1.101. Enter the default
address into a web browser, press Enter, and the welcome page shown in Figure 5 is
displayed.

a‘, @ hitp://1921681.101 P~ ¢ & welcome ]

Welcome Page

Welcome Page

Instrument Model TBX3000A
LAN Configuration
Firmware Revision: 200
I Corfuuration Serial Number 010625
Set Password LAN Connection Status Connected
WIFI Connection Status: Disconnected
Host Name (FQDN): Bench1.local.

Figure 5: Welcome page for TBX3000A configuration

The Welcome page shows the firmware version, serial number, LAN connection status,
WIFI connection status, and the hostname of the TBX3000A.

4 TekSmartLab User Manual
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LAN Configuration
Click LAN Configuration in the navigation bar on the left to show the LAN Configuration
page.
= | 5 )
[ LAN Configuration
&« C | [41921681101 wl =
LAN Configuration
Welcome Page
Hostname: Benchl
LAN Confi
Descripticn TBX3000A
LT BRI TCP/IP Configuration Mode: Manual
Set Password IP Address: 192.168.1.101
Subnet Mask: 255.255.255.0
Default Gateway 192.168.1.1
Connect Status: Connected
Speed 100Mbs
Modify
Teklmn/ix'

Figure 6: LAN configuration
Click Modify to configure the LAN parameters and the host name.

The default LAN configuration values are shown below:

Host Name Bench1
TCP/IP Configuration Mode Manual

IP Address 192.168.1.101
Subnet Mask 255.255.255.0
Default Gateway 192.168.1.1

TekSmartLab User Manual 5
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WIFI Configuration

Click WIFI Configuration in the navigation bar on the left to show the WIFI Configuration

page.

[ WIFI Configuration

Welcome Page
LAN Configuration
WIFI Configuration

‘ Set Password

<« C [7192168.1.101

[ S
ol =

WIFI Configuration
Hostname: Bench1
Description: TBX3000A
TCP/IP Configuration Mode: Auto
IP Address 169.254.73.87
Subnet Mask: 2552550.0
Default Gateway 192.168.1.1
SSID:
Connect Status Disconnected
Signal Intensity:

[ Meodify ] [ Scan AP J ‘

Tektron/lx'

Figure 7: WIFI configuration

Click Modify to configure WIFI network parameters.

Click Scan AP to search for the SSID of the WIFI network.

NOTE:

The TBX3000A will connect to the WIFI network, only after the USB WIFI dongle is
installed on the instrument.

TekSmartLab User Manual
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TekSmartLab User Manual

Set Password

Click Set Password in the navigation bar on the left to change the password for the
instrument.

o | B | e
[ Administratien x
« C [41921681.101 T E
Administration

Welcome Page
LAN Configuration Change Password:
WIFI Configuration
Set Password Current Password:

New Password

Confirm New Password:

Teklron}x'

Figure 8: Set password

You can change the password on this page. The default password is admin.
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TSL3000B Installation

Hardware and Software Requirements for the Server

Hardware Requirements

¥ CPU: 2.3 GHz dual-core or higher

¥ Memory: 4 GB DDR3 or higher

" Display: Resolution of 1366 by 768 or higher

¥ Storage: 160 GB or higher

Software Requirements

¥ Operating system: Win7 Professional, Enterprise, or Ultimate

¥ Net Framework 4.5 or higher (for installation instructions, please refer to
Installing .Net Framework)

" Internet Information Service: IIS 6.0 or higher (for installation instructions, please
refer to |IS Installation and Configuration)

" Database system: SQL Server 2014 Express or SQL Server2014 Enterprise (for
installation instructions, please refer to Installing SQL Server 2014 Express)

Installing TSL3000B

Visit www.tek.com, and search for ‘TSL3000B’. Search through the results and find the
latest version of the software. Download and install the software, following the software
installation instructions on screen.

Installing .Net Framework

Visit http://www.microsoft.com/en-US/download/details.aspx?id=30653, and choose the
language consistent with your operating system. Then download and install .Net
Framework 4.5. If you already have a higher version of .Net Framework installed on your
computer, you don't have to install this software.
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Installing SQL Server 2014 Express

TekSmartLab User Manual

Downloading the Installation Pack

Visit http://www.microsoft.com/en-
in/download/details.aspx?id=42299&WT.mc_id=rss_alldownloads_devresources, and
choose the installation pack consistent with the bit number of your operation system. For
example;

¥ For 64-bit Win7, choose ExpressAndTools 64BIT\SQLEXPRWT_x64_ENU.exe
" For 32-bit Win7, choose ExpressAndTools 32BIT\SQLEXPRWT_x86_ENU.exe

NOTE: The size of the installation pack is around 800MB.

The installation cannot be carried out if the bit number of the installation pack is not
consistent with your operation system.

Installing the Software

In this procedure, we use the 64-bit Win7 installation package as the example. This
section explains how to install the database system.

1. Double-click SQLEXPRWT_x64_ENU.exe, and choose the directory for extracted
files. The following figure is displayed.

Microsoft SQL Server 2014 Express with Tools &J

Preparing: D:\5ca2586b768603c2ee92dde 2a7 redist\DotMe. .. \WDP40-KB 2468587 1-V 2. EXE

Cancel

Figure 9: Extracting files
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You may have to wait up to two minutes while the installer extracts the TSL3000B
installation files. Then the following figure is displayed.

= = ]
45 SQL Server Installation Cents [FE=E S
Planning Lﬁ MNew SQL Server stand-alone installation or add features to an existing installation
. Launch a wizard to install SQL Server 2014 in a non-clustered environment or to add
Installati
fon features to an existing SQL Server 2014 instance. |
Maintenance |
i ﬁ Upgrade from SQL Server 2005, SQL Server 2008, SQL Server 2008 R2 or SQL Server 2012
ools
Launch a wizard to upgrade SQL Server 2005, SQL Server 2008, SQL Server 2008 R2 or SQL
Resources Server 2012 to SQL Server 2014.
Options l
(l
|
I
{
U
Microsoft SQL Server2014 |
|

Figure 10: Installation center
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2. Click New SQL server stand-alone installation or add features to an existing
installation. The following figure is displayed.

License Terms

To install SQL Server 2014, you must accept the Microsoft Software License Terms.

License Terms -
MICROSOFT SOFTWARE LICENSE TERMS

Global Rules I}
Microsoft Update MICROSOFT SQL SERVER 2014 EXPRESS
Product Updat

petieiy a_es These license terms are an agreement between Microsoft Corporation (or based on where you
Install Setup Files live, one of its affiliates) and you. Please read them. They apply to the software named above,
Install Rules which includes the media on which you received it, if any. The terms also apply to any Microsoft

' Feature Selection e updates,

Feature Rules

|| Feature Configuration Rules » supplements,

Installation P 2
installation Progress F7Y d
Complete Copy  Print

| [T 1accept the license terms. I

@] Turn on Customer Experience Improvement Program (“CEIP“) and Error Reporting to help improve the
quality, reliability and performance of Microsoft SQL Server 2014.

See the Microsoft SQL Server 2014 Privacy Statement for more information.

* Microsoft SQL Server 2014 also includes a Visual Studio component that will have CEIP settings tumed
off by default. If Visual Studio is installed, this component will use the CEIP settings for Visual Studio.

Figure 11: License terms

3. Select | accept the license terms.
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4.  Click Next. The program will check whether the files for installation are correct.

Install Setup Files

Global Rules
Microsoft Update

Product Updates

Install Setup Files

Install Rules

Installation Type

License Terms

Feature Selection

Feature Rules

Feature Configuration Rules
Installation Progress

Complete

E SQL Server 2014 5_
If an update for SQL Server Setup is found and specified to be included, the update will be installed.
—
Task Status
Scan for product updates Completed
Download Setup files Skipped
Extract Setup files Skipped
Install Setup files Skipped
< Back Next > Cancel

Figure 12: Setup files check
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After verifying the files, the following figure is displayed.

T SQL Server 2014 Setup

Feature Selection

Select the Express features

License Terms

Global Rules

Microsoft Update

Product Updates

Install Setup Files

Install Rules

Feature Selection

Feature Rules

Instance Configuration
Server Configuration
Database Engine Configuration
Feature Configuration Rules
Installation Progress

Complete

toinstall.

Features:

Feature description:

Instance Features

atabase Engine Services
SQL Server Replication
Shared Features

lient Tools Connectivity
lient Tools Backwards Compatibility
lient Tools SDK
Management Tools - Basic
Management Tools - Complete
SQL Client Connectivity SDK
[7] LocalDB
Redistributable Features

The configuration and operation of each
instance feature of a QL Server instance is
isolated from ather SQL Server instances. SQL
Server instances can operate side-by-side on

Prerequisites for selected features:

Already installed:
... Windows PowerShell 2.0

i Microsoft NET Framework 3.5
4| . »

Disk Space Requirements

Drive C: 2535 MB required, 23218 MB available

select All

Selec

Instance root directory:
Shared feature directory:

Shared feature directory (x86):

C\Program Files\Microsoft SQL Servert,
C\Program Files\Microsoft SQL Server',

CA\Program Files (86)\Microsoft SQL Server\

-

<Boc_|[_dear ][_Gnca [ Hep ]
Figure 13: Feature selection
5. Click Select All.
6. Click Next. The following figure is displayed.
ey~

T4 SQL Server 2014 Setup

Instance Configuration

License Terms

Install Rules

Feature Selection

Feature Rules

Instance Configuration

Server Configuration

Database Engine Configuration
Feature Configuration Rules
Installation Progress

Complete

SQL Server directony:

Instance Name

Global Rules *) Named instance: | MSSQLSERVER
Microsoft Update
Product Updates
Tnstall Setup Files Instance I MSSQLSERVER

Installed instances:

Instance 1D

Features

Specify the name and instance ID for the instance of SQL Server. Instance ID becomes part of the installation path.

C\Program Files\Microsoft SQL Server\MSSQL12. MSSQLSERVER

Edition Version

< Back H Next > H e H Help

Figure 14: Instance configuration

13



TekSmartLab™ TBX3000A, TSL3000B User Manual

14

1.
8.

Select Default Instance.

Click Next. The following figure is displayed.

" 4
4 SQL Server 2014 Setup e -— =|E
Server Configuration
Specify the service accounts and collation configuration.
License Terms m’m‘
Global Rules
Microsoft Update Microsoft recommends that you use a separate account for each SQL Server service.
Product Updates Service Account Name Password Startup Type
Install Setup Files SQL Server Database Engine NT Service\MSSQLSERVER Automatic M|
Install Rules SQL Server Browser NT AUTHORITY\LOCAL ... Dicabled M|
Feature Selection
Feature Rules
Instance Configuration
Server Configuration
Database Engine Canfiguration
Feature Configuration Rules
Installation Progress
Complete
<ok [ tear [ coneel ][ bep

Figure 15: Server configuration

9.

Click Next. The following figure is displayed.

r
5 SQL Server 2014 Setup

License Terms
Global Rules
Micrasoft Update
Product Updates
Install Setup Files
Install Rules
Feature Selection
Feature Rules
Instance Configuration
Server Configuration
Database Engine Ct

Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Server Configuration | Data Directories | User Instances | FILESTREAM

Specify the authentication mode and administrators for the Database Engine,

Authentication Mede

(©) Windows authentication mede

@ Mixed Mode (SQL Server authentication and Windows auth anticat\on)l

Specify the password for the SQL Server system administrater (sa) account.

Enter password: LTTTTPTT PR Y

Confirm password:  sessssssssssess| |

Feature Configuration Rules
Installation Progress

Complete

Specify SQL Server administrators

GLOBAL\Ichens3 (Ichen3)

Add Current User ] l Add... ] l Remove ]

SQL Server administrators
have unrestricted access
to the Database Engine.

[ < Back H Next > H = H Help

Figure 16: Database engine configuration
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10. For authentication mode, select Mixed Mode.

11.  Input the system administrator (sa) password “TekSmartLab2015”.

NOTE: This password is mandatory. Make sure that T, S, and L are all uppercase.

12. Click Next. The following figure is displayed.

75 SQL Server 2014 Setup § w— e —

D )

Installation Progress

License Terms

Global Rules — ey

Microsoft Update Tnstall_SqlSupport_Cpub4_Action : CreateShortcuts, Creating shortcuts
Product Updates

Install Setup Files

Install Rules

Feature Selection

Feature Rules

Instance Configuration

Server Configuration

Database Engine Configuration
Feature Configuration Rules
Installation Progress
Complete

Mext =

Figure 17: Installation progress

While this figure is being displayed, the database system is being installed. This typically
takes about 10 to 20 minutes to complete. When complete, the following figure is

displayed.
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3
%5 5QL Server 2014 Setup [E=gEER
Complete

Your SQL Server 2014 installation completed successfully with preduct updates.

Li T
lcense ferms Information about the Setup operation or possible next steps:

Global Rules
-
Microsoft Update - Feature Status il
Product Updates Management Tools - Complete Succeeded E|
) i Client Tools Connectivity Succeeded _J
Install Setup Files (2 Client Tools SDK Succeeded
Install Rules 1 Client Tools Backwards Campatibility Succeeded
Feature Selection @ Management Tools - Basic Succeeded
1 Datahase Fnaine Senvices Sucreeded s
Feature Rules
Instance Configuration
Server Configuration Details:

Database Engine Configuration

Viewing Product Documentation for SQL Server

Feature Configuration Rules E

Installation Pragress Only the components that you use to view and manage the documentation for SQL Server have
been installed. By default. the Help Viewer component uses the online library. After installing

R SQL Server. you can use the Help Library Manager component to download documentation to

your local computer. For more information, see Use Microsoft Books Online for SQL Server

(<http://go microsoft comdfwlink/?LinklD=299578:).

Summary log file has been saved to the following location:

Ci\Program Files\Microscft SQL Server\1 204 Setup Bootstrap\l cgZ0160607 132748\Summary W-SHPD-
LCHEN3-1 20160607 1327485t

T e

Figure 18: Installation complete
13. Click Close.

The installation of the database system is complete.
Configuring the Database

1. Select SQL Server 2014 Configuration Manager in the Start menu of Windows, as
shown in the following figure.

¢ nrmm e e
. Microsoft SQL Server 2014
a Download Microsoft SQL Server Cor
L SQL Server 2014 Import and Export C
L SQL Server 2014 Import and Export L[
Lz SQL Server 2014 Management Studi
. Analysis Services
Configuration Tools
[_E S0L Server 2014 Configuration v
i5 AUl Server LU14 Error and Usage
5 SOL Server 2014 Installation Cent
20 SQL Server 2014 Reperting Servic

* -

n

Figure 19: Select configuration manager

The path to this link is:
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Start >> All Program >> Microsoft SQL Server 2014 >> Configuration Tools >> SQL
Server 2014 Configuration Manager

2. Inthe SQL Server Configuration Manager, click SQL Server Network
Configuration >> Protocols for MSSQLSERVER, and then right-click TCP/IP in the
right panel as shown in the following figure.

Depending on the operating system, the SQL Server Network Configuration link might be
(32 bit) or (64 bit).

48 SQL Server Configuration Manager (Local) Protocol Name Status
B sQ serverServices 4 Shared Memory  Ensbled
. 5QL Server Network Configuration (32bit) Nsmed Pipes Disabled

> B sQLN fient 11.0 € tion (32bit)
® onfiguration (32bit) TR Disabled
H- Prot MSSQLSERVER
> MTetive Chent IT0 Contiguration

Figure 20: Enable TCP/IP protocol
3. Select Enable in the pop-up menu.

The following figure is displayed after you enable TCP/IP.

Sql Server Configuration Manager o 5 ]

s —— i —
File Action View Help

e[ 7B

48 5QL Server Configuration Manzger (Local) Protocol Name Status

5 QL Server Senvices ¥Shared Memory  Enabled
B 5QUServer Network Configurstion (32bit)

|| » 2 SQL Native Client 100 Configuration (32bit)
"R TCP/IP Enabled

|| o & sal server Network Configuration & el

f B Protocols for MSSQLSERVER

|| » & SQL Native Client 11.0 Configuration

I

Figure 21: TCPI/IP protocol enabled

4. Click SQL Server Services in the left panel. The following figure is displayed.

-
5 Sqi Server Configuration Manager | —— —— | — @g_ﬂ.
File Action Niew Help I
T ry
48 5QL Server Configuration Manager (Local) Name State Start Mode Log On As Process ID
£] SQL Server Services o 2
o Other (Boot, Syste...  NTAUTHORITY\LO... 0
L, sQL server Netwark Configuration (32bit) [ Toning r— 2 NT SenvicMSSQL. 6280
» 2 SQL Native Client11.0 Configuration (32bit
2. SQU Native Clies onfiguration (32bit) EPe] Other (Boot, Syste.. ~ NT AUTHORITY\ME... 0

4§ SQL Server Network Configuration
e Protocols for MSSQLSERVER
» B SQL Native Client 110 Configuration

Figure 22: SQL server services

5.  Click SQL Server (MSSQLSERVER) in the right panel.
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6. Click © in the tool bar to restart the SQL server service.
7. Close the window.

8.  Click Start >> All Programs >> Microsoft SQL Server 2014 >> SQL Server 2014
Management Studio, as shown in the following figure.

. Microsoft Silverlight
. Microsoft 5QL Server 2014
a Download Microsoft SQL Server Cor
L SQL Server 2014 Import and Export C

SQL Server 2014 Import and Export C
“z SQL Server 2014 Management Studi

. Analysis Services

. Cenfiguration Tools

. Integration Services
Figure 23: Select SQL Server Management Studio
9. Inthe Connect to Server window, select Database Engine for Server type.
10. Select the name of the computer for Server name.
11.  Select SQL Server Authentication for Authentication.

12. Enter sa for Login.

13. Enter TekSmartLab2015 for Password, as shown in the following figure.

| Connect to Server )

Microsoft SQL Server 2014

Serwver type: lData'base Enzine

Serwer name: ¥-SHPFO-LCHEKRS-1

Authentication: [SQL Server Authentication

Login: sa
Pazzword: Aotttk ok ok

Remember password

[ Commect l[ Cancel ][ Help ][ Options >

Figure 24: Connect to server

14. Click Connect to log in. The following figure is displayed.
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s [[ISG.

Figure 25: Main screen
15. In the left panel, right-click Database.

16. Select Restore Database from the popup menu, as shown in the following figure.

& Microsoft SQL Server Management Studic NN

File Edit View Debug Tools Window Help
F] e S e | L NewQuery [y i v i | &
Object Explorer * o x

Connect~ 3 3J m T (2] &
(=) La W-SHPD-LCHEM3-1 (S0L Server 12.0.20

B L]m Mew Database...
]
3 Sec Attach...
[ Sen Restore Database...
(3 Rep Restore Files and Filegroups...
3 Mai

Deploy Data-tier Application...
Import Data-tier Application...

Start PowerShell

Reports

Refresh

Figure 26: Restore database

17. Enter TSLDatabase next to Database.
18. Select Device.

19. Select”...".

20. Click Add, as shown in the following figure.
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3 Select backup devices

TSLDatabase

Restore to:

Restore plan
Backup sets to restore:
Restore  Name Component Type Server

Figure 27: Specify backup

Databas:

Specify the backup media and its Location for your restore operation ! I
Backup nedia type File

Backup gedia:

21. Find the file TSLDatabase.bak in one of the following directories:

- For 64-bit Win7: C:\Program Files (x86)\Tektronix\TekSmartLab\
TSLDatabse.bak

- For 32-bit Win7: C:\Program Files\Tektronix\TekSmartLab\ TSLDatabse.bak

NOTE: If you are not able to find the file, select All Files next to Files of type, as shown in

the following figure.

[l Locate Backup File - W-SHPD-LCHEN2-1

Backup File location C'Frogram Files (e86)4Tektr omin'\TekE

- PPLive
-3 99MailFlugin

-3 Segeulnput

[ TeanViewer

=3 Tektronix

[ ArbBxpress

- TelSmartLab
[#-{_1 appdata
(-3 CourseLib
-3 Dac

7-C3 Lib

-1 X886

4 [

0 Reference Aszemblies

+ [dappdata
[dCourseLib
[ Dee
[JLib
[dLog
[JReport
[J5Lieb

e

B |

File name: TSLDatabase hak

[Backup Files (. bkt trnik Log ﬂ

I

0K I { Cancel l

Figure 28: Change file type
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22. Click OK after you find the file, and the following figure is displayed.

f—

Source

*) Database

5 Select backup devices [ E

Specify the backup media and its Lecation for yowr restere cperatio:

Database:

Destination -
Database: Backup media iype: File

Restore to:

Restore plan .

Backup sets to restore:
Restore  Name  Compof

Figure 29: Backup file found

23. Select the file using the checkbox in the Restore column, and then click OK. The
following figure is displayed.

142 Restore Database - TSLDatabase =
() Ready
Select a page Hscript ~ |IF Help
|2 General
[ Files .
ource
4 Options
© Database:
@ Device: C:\Program Files (@6)\Tektroni\TekSmartLab\TSLDatabase.bak =
Database: TSLDatabase - ]
Destination
Dotahsse: TSLDatabase -
Restore to: The last backup taken (Monday, May 23, 2016 12:27:41 PM)
Restore plan
Backup sets to restore:
estore . Tlame Componert . Type | Gerver Database Tostion Tt LoN =
TSLDatabase-.. Database Full  W-SHPD-HAL4 TSLDatabase 2 102000000074500036  102000000076100(
Connection
&) W-SHPD-LCHEN-L [s2]
View connection properties
Progress !
« M ] 3
Done
@ Verify Backup Media
oK ] [ Cancel I l Help ]

Figure 30: Select the most recent database

24. Click OK to complete the configuration and a confirmation message is displayed, as
shown in the following figure.
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.

Microsoft SQL Server Management Studic

|

| Database 'TSLDatabase' restored successfully.

b

Figure 31: Database configuration complete

NOTE: If you had installed SQL Server 2008 R2 Express and restored the
TSLDatabase.bak before, select Options and then select Overwrite the existing
databse (WITH REPLACE) as below before restoring the file.

42 Restore Database - T

(I | 53

9 No backupset selected to be restored,

scipt - | [3Help

base (WITH REPLACE)
ings (WITH KEEP_REPLICATION)

B red database (WITH RESTRICTED_USER)

Standby file:

Recovery state RESTORE WITH RECOVERY.

Tail-Log backup

] Take tai-log backup before restore

Backup file:

Server connections
T 7] Close sisting connections to destination database:
87 W-SHPD-LCHENS-1 sa]

Prompt
] Prompt before restoring each backup

D) TheFullTest Upgrade

View connection properties

Progress
Ready

d, rebuilt, or reset for

Figure 32: Overwrite the existing database
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IS Installation and Configuration

Installing IIS in Win7

1. Click Start >> Control Panel >> Programs >> Turn Windows features on or off, and
then select Internet Information Services as shown in the following figure.

=@ = |

~ [ 4| [ seareh contral anel el

s e
@leﬁ' @fane\ > Prcg@

Control Panel Hoge E=f Programs and Feature,

l'*.,l Uninstall a program | g Turn Windouws features on or of]
L

System and Security View installed updates

Network and Internet

Hardware and Sound Default Programs

ElE =)

Change default setting| i
* Programs Setyour default progra|  TUrn Windows features on or off
User Accounts

Desktop Gadgets
Add gadgets to the ded

Run programs made for previcTETeTom= How to install a program
y E
™) of the feature Is turned on,

Appearance and

To turn & feature on, select its check box. To tum a feature off, dear its check box. A filed box means that anly part

@

Personalization @[]} Games

[C] | Indexing Service

Internet Explorer 8

Internet Information Services

| FTP Server

Web Management Tools

World Wide Web Services

@]} Application Development Features
[#] i .NET Extensibility

Restore desktop gadgel
Clock, Language, and Region

FreeFall Data Prof

&, | Java (32-bit)

Ease of Access

-

asp

[l

[@] .}y AsP.NET

@1} cat

[¥] || ISAPIExtensions
[¥] Ji ISAPIFilters

[¥] |} server-Side Incudes

@ [ ), Common HTTP Features
Health and Diagnostics
Performance Features

Security
T T TMEErE TATrmaTon SErVICEs MOStabIE WeD Care
Media Festures

Microsoft .NET Framework 3.5.1
Microsoft Message Queue (MSMQ) Server
Frint and Document Services

Remote Differential Compression

Remote Server Administration Tools

RIP Listener

® [C] ) services for NFS

]

Figure 33: Select Internet information services

NOTE:

If you are installing IIS for the first time, make sure that you follow the instructions above.

2. Browse to World Wide Web Services >> Application Development Features, and

then select the following:

NET Extensibility
- ASP.NET

- Cal

- ISAP Extensions
- ISAP Filters

- Server-Side Includes

TekSmartLab User Manual
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Browse to World Wide Web Services >> Common HTTP Features, and select the
following:

Default Document
Directory Browsing
HTTP Errors
HTTP Redirection

Static Content

3. Click OK.

NOTE: Make sure that Web Management Tools is selected by default.

After a few minutes, the installation will finish.

Installing IS for Web Server

1. Open the Internet Information Services (1IS) Manager on your computer one of
the following two ways:

Click Start, and enter IS in the search box. Then open the Internet Information
Services (IIS) Manager from the search results.

Right-click Computer, and then select Manage. You can find Internet
Information Services (lIS) Manager under Services and Applications, as
shown in the following figure.

Open
[i_‘ Manage

G TortoiseSVN v

Map network drive...
Disconnect network drive, ..

Create shortout
Delete
Rename

Properties

Figure 34: Open Internet Information Service Manager

2. Collapse the items in the left panel.

24

TekSmartLab User Manual



TekSmartLab™ TBX3000A, TSL3000B User Manual

W3 Internet Information Services (1IS) Manager

@ \J ‘@ » W-SHPD-BYAN1 » Sites » DefaultWebSite »

File  view

3.
4.

Under Sites, select Default Web Site.

Click Stop under Manage Web Site in the right panel, as shown in the following
figure.

Ready

= Features View |[7% Content View

= 2|
| & = @ -
Help
+ Default Web Site Home
| 1Bl Explore
a --“51 W-5HPD-BYAN1 (GLOBAL \byan 1) ) = Edit Permissions...
(2} Appiication Pacls Filter: - G0 - GyShow All | Groupby: Area - B i
4 (g Ste ASPNET B
b. Default Web Site & J— P . Bindings...
= =N |
'% N~ - 0 0= N H? @?J ab| [E] Basic settings...
NET NET NET Error NET NETProfle  METRoles  NETTrust NETUsers  Applcation  Comnecton View Applications
Authorizati... Complaton  Pages  Globalization Levels Settings Strings
View Virtual Directaries
¥ @ B
& 2 & [ 2
MachineKey ~Pagesand  Providers SessionStste  SMTP E-mai
Controls 5 e
I N B swop
€61 g =0 'y P = & g -
i&, g (/] =, (:EJ = Erowse *:80 (hitp)
Authentication  CGI Compression  Default Directory  ErrarPages  Handier HTTP  ISAPIFiters  Logaing o
ocument  Browsing Mappings Respo. Advanced Settings...
. Configure
35 4 o=
i) & i"‘ 2 = Limits...
MIME Types  Modules Output Request 5L Scttings =
Caching Fittering ® rep
Oniine Help
Management
Configuration
Editor

TekSmartLab User Manual

Figure 35: Internet Information Services (IIS) manager

b

25



26

TekSmartLab™ TBX3000A, TSL3000B User Manual

' Internet Information Services (I15) Manager

5.

| = |Features View || Content View

Right-click Sites and select Add Web Site..., as shown in the following figure.
6@ ‘E»W-EHPD-EYANI V Sites » ‘-- @ -
Fle View Help
Ll qé! Sites @ Addwebsite...
-4 gﬁ:;sgﬁ-:l‘:lpﬁfﬂmbvann Fiter: ~ 6o - GShow All | Groupby: Mo Grouping - Setweb Sit= Dl
= = - ® Hep
41é] Steg|__ D Status Binding Path
>3 @ AddwebSie... ‘ faltWebSite 1 Stopped (h...  =:80 (http) “%SystemDrive %\inetoubwwroot iz iy
#3 Refresh
[% switch to Content View

(H]e £K|w|o]%w]

Figure 36: Add a web site
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6. Enter SLWeb under Site name.

7. Under Physical Path, select one of the two directories for the SLWeb file.
- For 64-bit: C:\Program Files (x86)\Tektronix\TekSmartLab\SLWeb
- For 32-bit: C:\Program Files\Tektronix\TekSmartLab\SLWeb

8. Click OK, as shown in the following figure, to finish.

Add Web Site R =
Site name:

Content Directory
Physical path:
< rogram Files\Tektronin TekSmartLab\SLWeE > | .. |

Pass-threugh authentication

l Connect as... ] lTest Settings... ]

Binding

Type: IP address: Port:
http ~| All Unassigned ~ &0
Host name:

Example: www.contoso.com or marketing.contese.com

Start Web site immediately

Figure 37: Select the SLWeb file
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"E Internet Information Services (TIS) Manager

Configuring ASP.NET 4.0

1. Open Internet Information Services (IIS) Manager as described before.

2. Select the server name in the left panel (highlighted in the following figure).

LI

66) [‘53 b W-SHPD-BYAN1 »

& @ -

File View Help

— e
W-SHPD-BYAN1 (GLOBAL \byan
El- o] Sites

(-3 Default Web Site
- SLweb

Ready

28

@él W-SHPD-BYAN1 Home
L

Manage Server
-
Filter: - Bico - Ghshow Al | Groupby: Area - EE- 2 Restart
ASPNET P Start
B Stop
1= g“/ (* q - Els -T? 1 view Application Pagls
= o Sl - =b] o & e View Sites
NET NET NET Error NET MNETTrust  Application  Connection  MachineKey  Pagesand  Providers .
Authorizati...  Compilation Fages  Globalization  Levels Settings Srings Controls Change .NET Framework Version
g; ) @ rep
= Grline Help
Session State  SMTP E-mail
s
L2 @ 4 o 2 & €/ R
Authentication cal Compression Default Directory  Error Pages FastCl Handler HTTP N {5APT and CGI}
Document Browsing Settings Mappings Respo... | Restrictions :
& = ey @t X
O 8 = H ¥ = I 2
ISAPI Fiters Logging MIME Types Modules Output Request Server Warker
Caching Filtering Certificates  Processes
Management
B &
=%
Configuration  Feature Shared
Editor Delegation  Configuration

[ = Features View |\ Content View

Figure 38: IIS manager

%

3. Double-click ISAPI and GGI Restrictions in the middle panel.

TekSmartLab User Manual



TekSmartLab™ TBX3000A, TSL3000B User Manual

4. Right-click the two ASP.NET 4.0 entries to change the restriction to be Allowed, as

shown in the following figure.

‘E Internet Information Services (IIS) Manager

1ol x|
@E)\ [G_ii } W-SHPDBYANL * J & o e
File View Help
| Gi‘§l ISAPI and CGI Restrictions =
e
=-95 W-SHPD-BYAN1 (SLOEAL byan1) .
-1} Application Pools Use this feature to specify the ISAPI and CGI extensions that can run on the Web server, Allow
=g Edit...
E-y Sites Group by: Mo Grouping ¥
(-5 Default Web Site - - K Remove
- Description_~ | Restriction [[Path
SLweb
ASPNET v2.0,50727 Allowed

Sawindir ¥e\Microsoft, NET\Frameworké4\v 2.0, 50727 \aspnet_isapi.dll

Edit Feature Settings...
ASP.NET v2.0.50727 Allowed Sowindir ¥o\Microsoft. NET\Frameworkw 2.0, 50727 \aspnet _isapi.dll @ Help
ASP.NET v 9 ISP
= Online Help

ASP.NET v4.0.30319 Not Allowed Add... bwork64\v4.0.30319\aspret_isapi.c

Allow

Edit...

K Remove

Edit Feature Settings...

@ Help
d I Online Help —I LI
[=|Features view |2 Content View

Configuration: localhost’ applicationHost.config

4
Figure 39: Allow ASP.NET 4.0

After you've changed the status of the two entries, the following figure is displayed.

*E Internet Information Services {IIS) Manager
@g‘) [ &5 v wsrpoBran: »

File Vview Help

| &“‘gl ISAPI and CGI Restrictions
b
=- 051 W-SHPD-BYAN1 (GLOBAL\byan1) X § .
Application Pools Use this feature to specify the ISAPI and CGI extensions that can run an the Web server,
- & Sites Group by: No Grouping =

- Default Web Site P o I = I o I
SLWeb [—— striction 3 [
#ASP.NET v2.0.50727 Allowed Sowindir 3%t \Microsoft, NET\Frameworké4\y 2,0, 50727 \azpnet_izapi.dll
ASP.NET y2.0.50 A

Sowindir ¥ \Microsoft. NET\Framework'w 2.0, 5072 \aspret_isapi.dil
Cr\Windows\Microsoft. NET \Framework'w4.0. 30319 aspnet_izapi.dll
C:\Windows\Microsoft, NET\Frameworks4'w4.0.30319\aspnet_isapi.dil

5P NET v4.0.30319
ASP.NET v4.0,30319

Allowed

Figure 40: ASP.NET 4.0 allowed
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NOTE: Under some conditions, you may not be able to find ASP.NET v4.0, as shown in

the following figure.
*-E]nternet Information Services (IIS) Manager i m) 1[
@F; [ 93 » wspoavan: » | & @ -
Eile Miew Help
| Q'§l ISAPI and CGI Restrictions -
2
=95 W-SHPD-BYANL (GLOBAL'byan1) "
:j 5 Applicati { i byan) Use this feature to spedify the ISAPT and CGI extensions that can run on the Web server. Edit Feature Settings...
E‘ .pp\cahun Pools —
E-[6] Sites Group by: Mo Grouping - @ reb
[ Default Web Site i
g SI.E\"I:I: = Description = | Restriction I Path Online Help
ASP.MET v2.0.50727 Allowed Sowindir Y \Microsoft, MET\Frameworké4\v 2.0, 50727 aspnet_isapi.dil
ASP.NET v2.0.50727 Allowed Sowindir S Microsoft. NET\Frameworkv 2.0, 50727 \aspnet_isapi.dll
4| |
E] Features View |- Content View
Configuration: ‘localhost’ applicationHost. config ei:g

Figure 41: ASP.NET v4.0 not found

In this case, you can solve the problem by using a DOS command (as administrator).

a.  Under Start >> All Programs >>Accessories, right-click Command Prompt.

b. Select Run as administrator.

c.  Enter one of the following commands in the window:

= For 64-bit Win7:
C:\Windows\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis.exe —i

= For 32-bit Win7:
C:\Windows\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis.exe —i
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You can also copy and paste the command in the window, as shown in the following
figure.

Administrator: Command Prompt

Microsoft Windows [Version 6.1.76811
Copyright <c> 288? Microsoft Corporation. HAll rights reserved.

C:WINDOUWSSNsystem3d2>
Mark
Copy Enter:
Select All
Seroll
Find...

Figure 42: Paste command by right key

After you enter the command, the following figure is displayed.

Administrator: Command Prompt

Microsoft Windows [Uersion 6.1.76811
Copyright <{c> 2889 Microsoft Corporation. All rights reserved.

C:SWINDOWS “system32>C: “Windows “Microsof t .NET “Framework64 w4 . 8.3831? aspnet_regii]
s .exe —1i

Figure 43: Command window after entering the command
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Press Enter to run the command, the following figure is displayed.

Administrator: Command Prompt
Microsoft Windows [Version 6.1.76811
Copyright <c)> 288? Microsoft Corporation. All rights reserwved.

Gz S\WINDOWS ~system32 >C:“Mindows “\Microsof t .NET “Frameworko4 w4 .8._30831? aspnet_regii]
s.exe —1i

Microsoft (R> ASP.MET ReglIS version 4.8.38319.17929

Administration utility to install and wninstall ASP.HET on the local machine.
Copyright {C) Microsoft Corporation. All rights reserved.

Start installing ASP.NET (4.0.38319.17929)>.

Finished installing ASP.NET <(4.8.38319.1792%>.

C: \MINDOWS \system32>

Figure 44: Result of the command running

As shown in the figure, ASP.NET v4.0 is installed. You should now be able to configure
ASP.NET v4.0 according to the procedures described in this section.
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Fle Action View Help

Configuring ASP.Net State Server

1. On the desktop, right-click Computer.

2. Select Manage. The Computer Management screen is displayed, as shown in the
following figure.

£8 Computer Management

g [=[ 3]

eslze0 o @E> 80D

() Task Scheduler
@ Event Viewer
{z| Shared Folders

@E‘l:l Performance
= Device Manager
[ =5 Storage
=¢ Disk Management
B ::q Services and Applications
!

wyfifs)

I%I!EHI !’Ill aation Serv

at Computer Management (Local
B )

_-E Local Users and Groups

SQL Server Configuration

|

ASP.NET State Service

Start the service

Description:

Provides support for out-of-process
session states for ASP.NET, If this
service is stopped, out-of-process
requests will not be processed. If this
service is disabled, any services that
explicitly depend on it will fail to start.

MName =

| Description I Status

£+, Application Layer Gateway Service Providess...

| startup Type

| Log On As

Manual

Local Service

L Applicati

Manual

ervIE

L Aud

£+, Background Intellgent Transfer ...

£+, baidupcsuiteservice.exe

“, Base Filtering Engine

%, BDHY Service

“, BDKVRTP Service

% BDMRTP Service

£, BDSGRTP Service

£ BitLocker Drive Encryption Service
£ Block Level Backup Engine Service
‘4 Bluetooth Support Service

£ Bonjour Service

i BranchCache

£ Certificate Propagation

£ Cisco AnyConnect Secure Moabilit...

£ CNG Key Isolation

£ COM+ Event System

£ COM+ System Application

£+, Computer Browser

£+, ConfigMgr Task Sequence Agent

£+, Configuration Manager Remote ...

£+, Credential Manager

£+, Credential Yault Host Control Ser...

£+, Credential Vault Host Storage
£ Cryptographic Services

£, DCOM Server Process Launcher
L Defsry

£+, Desktop Window Manager Sessio. ..

£, DHCP Client

Transfers f...

The BaseF...
BERH...
ERARAR. .
BEIL..
BETZ..
BOESVC ho...
The WBEM...
The Blueto...
Enables ha...
This servic...
Copies use...
Cisco AnyC...
The CNG k...
Supports ...
Manages t...
Maintains a...
ConfigMar ...
Provides th...
Provides s...
Host Contr...
Host Stora...
Provides fo...
The DCOM. ..

Provides D...
Registers a...

Started
Started

Started
Started
Started
Started
Started
Started

Started

Started
Started
Started
Started
Started
Started
Started

Automatic (D...
Automatic
Automatic
Automatic
Automatic
Automatic
Automatic
Manual
Manual
Manual
Automatic
Manual
Automatic
Automatic
Manual
Automatic
Automatic
Manual
Manual
Automatic {D...
Manual
Automatic
Automatic
Automatic
Automatic
Automatic
Automatic
Automatic

Tocal System
Lacal System
Lacal System
Local Service
Local System
Local System
Local System
Local System
Local System
Local System
Local Service
Local System
Network S...
Local System
Local System
Local System
Local Service
Local System
Local System
Local System
Laocal System
Laocal System
Laocal System
Laocal System
Network S...
Laocal System
Laocal System
Laocal System
Local Service

Extended 4 Standard /'

More Actions 4

Figure 45: Computer management

3. Select Computer Management (Local) >> Services and Applications >> Services.

4.  Select ASP.Net State Service in the right panel to confirm that the status is ‘Started’
and Startup Type is ‘Automatic’.
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If not, change them by following the steps:
1. Right-click ASP.Net State Service.
2. Select Start or Restart.

3. Double-click ASP.Net State Service.

4. Change the Startup Type to Automatic, as shown in the following figure.

gCompllter Management I — 3 x|
File Action View Help
e | fF Bk HE > mn®
A Computer Management (Local)
B [/} System Tools
@ Task Sd.maduler ASP.NET State Service Name + | Description I Status | Startup Type | Log On As
@ ::E”t::'?:r  Application Host Helper Service Provides a...  Started Automatic Local System
i i} EFFU 5 Er; a Start the service £ Application Identity Determines... Manual Local Service
.'{(‘1\ Poe:‘:\nrr:::c:n FL £ Application Information Faciitates ...  Started Manual Local System
S : . £ Application Layer Gateway Service  Provides s... Manual Local Service More Actions 4
=4 Device Manager Description: oy
5 £ Storage Provides support for out-of process £ Application Management Processes i... Manual Local System
L) <
=¥ Disk Management session states for ASP.NET. If this £ ASP.NET State Service Provides s... Manual Netwaork 5.
Services and Applications service is stopped, out-of-process £ Audio Service Managesa... Started Automatic Local System
requests will not be processed. If this el ASP_NET State Service P ses (L G E x|Im
'q) Isnber.net Information Serv service is disabled, any services that - d ate Service Properties (Local Computer] x| i
Ervices = 3 .
= explicitly depend on it will fail to start. “ 7
WMI Control 4 Base Fitter | GenewEl I Log On | Hecovery' Dependencies | e
SQL Server Configuration £, BDHY Sery m
% BDKVRTP ¢ Service name:  aspnet_state -
"/BOMRTPS  Displayname:  ASP.NET State Service m
&% BDSGRTP | : : r m
ZE BitLocker Description: }Esomdes support for out-of-process seasion states for a -
“ P.MNET. F this service is stopped, out-of process
‘. Block Leve s i LI m
e Blue.bomh Path to executable: a
~BOMIOUr S o iNDOWS  Microsoft NET' Framework64'w4.0.3031 Saspnet_stote s | |
£ BranchCac .
£ Certificate Startup type: m
£ Cisco Any( m
CECNG Key T Help me corfigure service startup options m
£ COM+ Eve e
- COM+ Sye Service status:  Stopped m
S Computer 5 | 5 | 5 R m
2% ConfigMgr tart tap ALEE ESUME: -
Configurat ‘You can specify the start parameters that apply when you start the service m
% Credential from here. m
£ Credential m
i Credential | Start parameters: I m
% Cryptogra
£ DCOM Ser m |
1 | _’I Extended A Standard / oK I G Py |

Figure 46: Configure ASP.Net State Service
5. Click OK to complete the setting.

6. Close the Computer Management screen.
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Windows Firewall Configuration

You can open the firewall setting screen by navigating to Start >> Control Panel >>
System and Security >> Windows Firewall >> Advanced Setting'.

Adding Inbound Rules
1. Double click Inbound Rules and then right-click it to display the pop-up menu.

2. Select New Rule..., as shown in the following figure.

il
Fle Action View Help
| Actions
Gow - Fohe
UKLLUSERSPRDFILE%\Apphcahan Datallnput ... Domain  Yes Allow d New Rule...
l.ALLUSERSPROFILE %% \Application Data\Input ... Domain  Yes Allow )
Filter by Sta 4 PR OGRAMFILES %6 \Products\Input Processar... Domain  Yes Allow ' Filter by Profile 4
Filter by Group ¥ lPROGRAMFILES % \Products\Input Processor... Domain  Yes Allow P Filter by State »
EOACDDA Public Yes Allow
e " borooos Public  Yes Allow 7 Fiter by Group '
Refresh 0O AODBA UDP Port Public  Yes Allow View »
ExpartList... -Zip File Manager Domain  Yes Allow
N R @ Refresh
Help -Zip File Manager Domain  Yes Allow
wrrigilent Communications Fabric Al Yes Allow |5+ Exportlist...
@Agilenﬁ:onnecﬁonExpert All Yes Allow Help
baidubrowser exe Domain  Yes Allow
@ba\dubruwser.exa Public Yes Allow
baidubrowser .exs Domain  Yes Allow
@ba\dubruwser.exa Public Yes Allow
baidubrowser .exs Private  Yes Allow
@ba\dubmwser.exe Private  Yes Allow
@BDAIadd\nAssistant Public Yes Allow
@BDAIadd\nAssismnt Public Yes Allow
@BDAIadd\nAsslstant Public Yes Allow
@BDAIadd\nAssismnt Public Yes Allow
@BDAIadd\nAsslstant Public Yes Allow
@BDAIadd\nAssismnt Public Yes Allow
@BDAIadd\nAsslstant Public Yes Allow
@BDAIadd\nAssismnt Public Yes Allow
@BDAIadd\nAssistant Public Yes Allow
@BDAIadd\nAssismnt Public Yes Allow
@BDADDUpdaber Public Yes Allow
@BDAppUpdat&r Public Yes Allow
@bduashrepurt.exe Public Yes Allow
@bduashreport.exe Public Yes Allow
@bduashrepurt.exe Domain ~ Yes A\IDW_ILI
4 | K 3
[Mew Rule. .. [
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3. Select Port, and then click Next, as shown in the following figure.

* New Inbound Rule Wizard x|

Rule Type
Select the type of firewall rule to create.

Steps:

» Rule Type What type of rule would you like to create?

@ FProtocol and Ports

@ Action " Program

o Profile Fule that controls connections for a program.

Rule that controls connections for a TCP or UDP port.

" Predefined:

IanchCacha - Content Retrieval {Uses HTTP) j
Fule that controls connections for a Windows experience.

" Custom
Custom rule

Leam more about nile types

< Back Mext > Cancel

Figure 48: New inbound rule wizard

36 TekSmartLab User Manual



TekSmartLab™ TBX3000A, TSL3000B User Manual

4. Select TCP.

5.  Select Specific Local ports.

6. Enter 80 next to Specific Local ports.
7. Click Next.

# New Inbound Rule Wizard x|

Protocol and Ports

Specify the protocols and ports to which this rule applies.

Steps:

@ Rule Type Does this rule apply to TCP or UDP?
+ Protocol and Ports @

@ Action DP

@ Profie

@ MName

Does this nule apply to all local ports or specific local ports?

Al

+ Specific local ports: ||ED| i

Leam more about protocol and ports

<gack || nex> Cancel

Figure 49: Protocol and ports
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8. Select Allow the connection, and then click Next.

* New Inbound Rule Wizard x|

Action

Specify the action to be taken when a connection matches the conditions specified in the rule.

Steps:
» Rule Type What action should be taken when a connection matches the specified conditions?
@ FProtocol and Ports
e (+ Allow the connection
on is includes connections that are protected with IPsec as well as those are not.
@ Profile
N " Allow the connection if it is secure
; ame This includes onty connections that have been authenticated by using IPsec. Connections
will be secured using the settings in IPsec properties and rules in the Connection Security
Rule node.

Customize ... |

" Block the connection

Leam more about actions

< Back Meat > Cancel

Figure 50: Action
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TekSmartLab User Manual

Select all three checkboxes and click Next, as shown in the following figure.

* New Inbound Rule Wizard

Profile
Specify the profiles for which this rule applies.

Figure 51: Profile

39



TekSmartLab™ TBX3000A, TSL3000B User Manual

10. Enter Web under Name.
11.  Click Finish, as shown in the following figure.

* New Inbound Rule Wizard I ) x|

Name

Specify the name and description of this nule.

Steps:
@ Rule Type
@ Protocol and Ports
@ Action
& Profils e
'Web
» Name
Description {optional):

<gack || Bush | Cancel

Figure 52: Name

After you click Finish, the following figure is displayed.
"ol

Fie Acon View Help

=R

und Rules T L e ! l!.-\.oml Address &
By Connection Security Rules
‘; Manitaring — TEPROTIE Pt . — . e Ay
@%ALLUSERSPRDFILE%\Appl\canun Data\input ... Doman Vs Mow Mo TALLUS... Any
@%PROGRAMFILES%\Dmducts\lnputhcessur.H Domain ~ Yes Alow Mo %PROG... Any
@%PROGRAMFILES%\Drodum\lnputPrucessor.H Doman ~ Ves Mow Mo %PROG... Any
@MOEODDF\’ Public  Yes Mow Mo C\Progr...  Any
@MOEDDM Public  VYes Mow Mo C:\progr... Any
(0 0069 LDP Port Public  Yes How Mo Any Any
@7—pr File Manager Doman ~ Ves Mow Mo CProgr... Any
{077 Fie Manner Nomain Ve Hlow N P Bnu

Figure 53: Inbound rules added
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Adding Outbound Rules

Double-click Outbound Rules and right-click it again. Repeat the steps for adding
inbound rules to add outbound rules. The following figure indicates that you have

successfully added outbound rules.

* Windows Firewall with Advanced Security

Fle Acton View Help

&9 a0

? Windows Firewall with Advanced 5 iRl (23

Any

Inbound Rules —
Outbound Rules: hez 1= g l:l.u.u.-_“
8 Connection Security Rules C% A fes Alow Ay
:‘;‘ Meritoring @Care Networking - De: RV fieiag o o oy ANy
@Cara Networking - Packet Too Big (ICMPvé-.. Doman  Yes Allow Any Any
@Care Networking - Parameter Problem (ICMP... Domain~ Ves Allow Any Any
@Cara Networking - Time Exceeded (ICMPvE-,.. Doman  Yes Allow Any Ay
@\xiﬁ\”nw Al Yes Allow Any Any
@\xiAHow Al Yes Allow Any Any
@\xiAHow Al Yes Allow Any Any
@\xip\”ow Al Yes Allow Any Any
@Natwurklng - Destination Unreachable {ICMP... Domain ~ Yes Alow Any Any
@Netwnrking - Parameter Problem (ICMPy4-Out) Domain ~ Yes Allow Any Any
@ MNetworking - Redirect (ICMPv4-Out) Domain ~ Yes Allow Any Any

Figure 54: Outbound rules added

Close all the windows once you are finished.

Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
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Testing the Web Server

1. Open Internet Information Service (IIS) Manager as described before.

2. Select Application Pools in the left panel, as shown in the following figure.

“E Internet Information Services (T15) Manager == x|
@g\‘ [ @ » wsHeoBYANL v Appiicaton Pools

| &= @ - |

Fle View Help

[pctons
# | Q'él Application Pools

£ Add Application Pool...
OBAL'\byan1)

3 Set Application Pool Defaults... |
o This page lets you view and manage the list of application poals on the server. Application pools are assaciated with warker processes, contain ane or more il s
iy, s applications, and provide isolation amang different applications. Appcation Poal Tare

&) Default Web Site Filter: - 50 ~ lghShow All | Group by: N Grouping - B Start

- SLweb

@ swel Name = | status | .NETFrame... [ Managed Pipeli... | Identity | Appiications | B stop
LEFASP.NET v4.0 Started 4.0 Integrated ApplicationPoollden... 0 Recyde
L} ASP.NET v4.0 Classic Started w40 Classic ApplicationPoaliden... 0 ikt Appl
L2} Classic .NET AppPoal Started w40 Classic ApplicationPoallden... 0 ] e
2} DefaultapoPool i 1 asic Settings. .,

:@E Started 4.0 Classic ApplicationPoollden. . T Recyding...
Edit Application Pool " 2] x| Advanced Settings...

Rename

Name:

= K Remove

IpLWEb

.NET Framework version: ! View Applications
|-NET Framework v4.0.30318 =] @ Help

Managed pipeline mode: Online Help

Classic =

¥ start application pool immediately

Cancel

Content View

Ready

&

Figure 55: Application pools
3. Confirm that the parameters of SLWeb in the right panel are correct:

- The version of .NET Framework should be 4.0 (or a version consistent with
what is installed).

- Managed pipeline mode should be Classic.

If the parameters are something else, you can double-click the entry to modify them.
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"E Internet Information Services (I15) Manager

4. Click SLWeb in the left panel under Sites.

5.

Click Browse*:80 (http) in the right panel, as shown in the following figure.

=8|
| & = 1@ -

6@ [o ¥ W-SHPD-BYAN1 » Sites » SLWeb »

File View Help

= W-SHPD-BYAN1 (GLOBAL\byan1)
2} Application Pools

0 SLWeb Home

@ 9 o

Authentication cal Compression  Default Directory
Document  Browsing
o -
= M =¥ &
MIMETypes  Modules Output Request  S5L Settings
Caching Filtering
Management
Configuration
Editor

2 &

Handler
Mappings

Error Pages

&

HTTP ISAPI Fiters
Respo...

Filter: - Bfico - Gshow all |Groupby: Area EER
ASP.NET
= N - 3 y ®x =
2 &£ @ ® [ 8 = ) F =
NET NET NET Errar NET .NET Profile NET Trust Application Connection  MachineKey  Pages and
Authorizati... Compiation Pages Globalization Levels Settings Strings Controls
Session State  SMTP E-mail
s

i

Logging

2! Explore

Edit Permissions. ..

Edit Site

Bindings...

[E] Basic settings. .

view Applications

Wiew Virtual Directories
Manage Web Site

2 Restart

P Start

B Stop

Browse Web Site
Advanced Settings. ..

Configure
Limits. ..

@ Help

Online Help

| = |Features View |- Content View

Ready

Figure 56: SLWeb home
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Windows will automatically open Internet Explorer to http://localhost/. You can also enter
http://localhost/ or http://127.0.0.1/ in the address box of your Web browser to visit the
web page.

The following figure is the web page displayed.

-
e _—::;‘ http://localhost ,0; 2D localhost

Lab Name: TekSmartLab

Bench:

M fro b
Course Name: Scope Tutg "==°9° omwebpage

Exersise: Rise and fall tim I, Pleaseinput bench number!

Student Name:

Student ID:

[JRemember me
Scope Snapshot

Figure 57: TekSmartLab web page

This web page indicates that the TekSmartLab web server works fine. (You can ignore the
caution message in the figure above. When you visit the web page using a QR code, you
will not see this message.)

If you are not able to visit the web page, please refer to IIS Installation and Configuration
and confirm that IIS is properly configured.
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TSL3000B

General Information

Home Page

The TSL3000B home page is shown as in the following figure.

Tektronix TekSmartLlab™ Home Setting Administrator Abou!

TekSmartLab

=+ Instructor Tektronix

Saved Config Exercise Material
Course  scope tutorial

Exercise  Rise and fall time meas ~ Configure

Instrument
Report Template

Total Instruments
Normal
Error

Disconnected Test Report

Figure 58: Home page

1. The menu bar: Menus allowing you to configure the software.
Course and exercise information: Controls to create and configure the courses
and exercises in this area, as well as other related settings.

3. Configure instruments: Configure the instruments in batch by clicking this
area.

4. Testreport: View the test report submitted by students by clicking this area.

5. Lab information: Monitor and modify the parameters of instruments on certain
bench by clicking this area.Displays the bench status and instrument status in
the lab.

TekSmartLab User Manual 45



TekSmartLab™ TBX3000A, TSL3000B User Manual

Menu bar
Click Home on the menu bar to return to the main page.
Change language

Click Setting -> Language on the menu bar to change the software language, as shown
in the following figure.

Tektronix TekSmartlab™ Home Setting Administrator About
Language » Chinese
Bench/Lab Layout Config English
General Information wtLab
Firmware/Courseware Update

#+ Instructor Tektronix @} %’

Saved Confi Exercise Material
Course Scope tutorial g

Exercise  Rise and fall time meas ~ Configure

Instrument
Report Template

Total Instruments
Normal

Error

Disconnected Test Report

Figure 59: Change language
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Lab General Information

Click Setting -> General Information on the menu bar to change the lab general
information.

Tektronix TekSmartLlab™ Home Setting Administrator About
Language
Bench/Lab Layout Config
General Information wrtLab
Firmware/Courseware Update

=+ Instructor Tektronix @} %

Saved Config Exercise Material
Course Scope tutorial

Exercise  Rise and fall time meas ~ Configure

Instrument
Report Template

Total Instruments
Normal
Error

Disconnected Test Report

Figure 60: General information

The following figure is displayed after you click General Information. You can change the
lab name in the upper part of the page.

Tektronix TekSmartlab™ Home Setting Administrator About

General Information

Lab Information

Lab Name TekSmartLaby

QR Code Generation QR Code Pnint Preview

Bench1
Server IP WiFi

Single Bench NO.

Batch

Width(Unit:mm)
Comments
hitp:/134.64.230.81/login.aspx?deskid=1

Print

Figure 61: Edit general information
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Change the password

Click Administrator -> Change Password on the menu bar to change the password, and
the following dialog box is displayed.

Tektronix TekSmartlab™ Home Setting Administrator About

TekSmartLab

= Instructor Tektronix M ﬁ @

Enter administrator password

. »rial
ourse Scope tutorial v
Password.

Default password is "admin”

Exercise  Rise and fall time meas ~ Configure

OK Cancel Instrument
ate

Total Instruments
Normal
Error

Disconnected Test Report

Figure 62: Change password

Input the old password, the following dialog box is displayed. The default password is
‘admin”

Tektronix TekSmartLab™ Home Setting Administrator About

TekSmartLab

=+ Instructor Tektronix - m @
d :

Change Passwort

al
Course Scope tutorial Old Password

New Password

Exercise  Rise and fall time mez

Confirm Password Configure
Instrument
OK Cancel

Total Instruments
Normal
Error

Disconnected Test Report

Figure 63: Input new password
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Input the old password again and the new password twice, and click Yes. Then the
password is changed.

Software Activation

Click About -> Software Activation on the menu bar to activate the software.

Telitronix' TekSmarilab™ Home Setting Administrator About
Software Activation
About

TekSmartLab

= Instructor Tekironix

- Saved Config Exercise Material
Course Scope tutorial

Exercise  Rise and fall time meas ~ Configure

Instrument
Report Template

Total Instruments
Normal

Error

Disconnected Test Report

Figure 64: Software activation
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1. The following figure is displayed.

Tektronix TekSmarilab™ Home Setting Administrator About

TekSmartLab

Software Activation

= Instructor Tektronix

Software SN. HWTJ20MJ
Course  scope tutc

Activation Code 6339-VN39.0FV2.-3.

Exercise  Rise and f Configure

Instrument

Total Instruments
Normal
Error

Disconnected Test Report

Figure 65: Input license

8. Enter the license you received from Tektronix next to Activation Code. Click
Active to activate the software.

NOTE:

The Software SN is generated automatically when the software is installed on the
computer. Trial Version means the software is the trial version and supports only 5
benches. It will change to Full Version after activation.

Once you purchase the TSL3000B software, Tektronix will send you the activation code
you need to activate your software.
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About

Click About -> About on the menu bar to display the software information, as shown in
the following figure.

Tektronix TekSmartLab” Home Setting Administrator About

TekSmartLab

#+ Instructor
About

Course
TekSmartLab(TM)

Version: 3.0.0

Exercise Configure
For more information, please visit the website

Instrument
www tek com/teksmartiab

Total Instruments
Normal

Error

Disconnected Test Report

Figure 66: Software information
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Lab Instrument Management

This part describes how to manage the instruments in the lab more effectively with
TekSmartLab.

Configure Bench and Lab Layout

You can click Setting -> Bench/Lab Layout Config to set the lab layout as well as the
bench layout.

Tektronix' TekSmartlab™ Home Setting Administrator About
Language
Bench/Lab Layout Config
General Information wrtLab
Firmware/Courseware Update

=4 Instructor Tektronix C

= 4

5 Saved Config Exercise Material
Scope tutorial

Exercise  Rise and fall time meas ~ Configure

Instrument
Report Template

Total Instruments
Normal
Error

Disconnected Test Report

Figure 67: Bench/Lab Layout Config
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Bench Layout Setting

The following figure is displayed when you click Bench/Lab Layout Config. The Bench
Layout Configuration tab is chosen.

Tektronix' TekSmariLlab™ Home Setting Administrator About
Bench Layout Configuration Lab Layout Configuration
Bench Layout

1 Oscilloscope v 2 Arbitrary Function Generator v
CH 1 Output [ON Output OFF

- Exémplé

Example

Digital Multimeter v 4 Power Supply X

Default Setup Default Setup

-123.125 mV
Example o EmXample

Range 1000 V

Figure 68: Bench layout configuration tab

You can choose the bench layout templates in the Bench Layout Configuration tab. The
Four-instrument layout template is chosen by default, as shown above.

You can click the arrow in the upper right corner of the square representing each
instrument to choose the type of the instrument, as shown in the following figure. Scope
represents oscilloscope, AFG represents Arbitrary Function generator, DMM represents
digital multimeter, and PWS represents power supply.

Telitronix' TekSmariLab™ Home Setting Administrator About

Bench Layout Configuration Lab Layout Configuration

Bench Layout
v 2
Scope
AFG
DMM
PWS

Example Example

Example

Example

Figure 69: Choose the instrument type
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The following figure shows the bench when four instruments are chosen.

Tektronix' TekSmartlab™ Home Setting Administrator About
Bench Layout Configuration Lab Layout Configuration

Bench Layout ==

1 Oscilloscope v 2 Arbitrary Function Generator v
CH 1 Output [ON Output OFF

Example

3 Digital Muttimeter v 4 Power Supply

Defauit Setup Default Setup

-123.125 mV
Example

Measurement  DC V %

Range 1000 V v

Figure 70: Instruments chosen

You can click Apply in the upper right corner of the page to apply the settings to all the
other benches in the lab.

A dialog box for you to confirm is displayed. Click Yes, the bench settings are applied to
all the benches in the lab.

If you try to apply the settings without choosing the instruments, a warning pops up.
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Lab Layout Setting

Select the Lab Layout Configuration tab, as shown in the following figure.

Tektronix' TekSmarilab™ Home Setting Administrator About

Bench Layout Configuration Lab Layout Configuration
Number sy Row 5 4 Column 38 +  Total

2 4

DMM Scope | AFG | DMM  Scope | AFG | DMM 5 | DMM G Scope

PWS PWS PWS

DMM S 5 | DMM G | DMM 5 | DMM ope MM G DMM

DMM  Scope DMM DMM 5 | DMM  Scope DMM c DMM

PWS

DMM DMM  Scope DMM DMM 5 | DMM e DMM c o DMM

PWS

DMM DMM  Scope DMM  Scope DMM 5 | DMM e DMM  Scope DMM

PWS PWS

Figure 71: Lab layout configuration tab
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You can arrange the layout by input the number of rows and columns in the Lab Layout
Configuration tab.

You can number the benches by rows or columns. The benches are numbered by rows in
the figure below.

You can double-click a bench to delete it, as shown in the following figure. You can also
double-click the blank to add the bench back.

Tektronix TekSmartLab™ Home Setting Administrator About

Bench Layout Configuration Lab Layout Configuration

Number | 8y Row Row 5 ¢ Column 8 4 Total 34

3

DMM J Scope | AFG

PWS

G | DMM Scope

PWS

Scope

PWS

23

Scope | AFG cope | AFG | DMM | {Scope [ AFG | D Scope
PWS

30

Scope | AFG | DMM | |Scope | AFG | DMM | {Scope | AFG | DMM | {Scope

PWS PWS PWS PWS

Figure 72: Arranging benches

NOTE: If you switch between numbering the benches by row and by column, the adding
and deleting done previously will be canceled.
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You can also select Manual to number the benches manually, as shown in the following
figure.

Tektronix' TekSmarilab™ Setting Administrator About

Bench Layout Configuration Lab Layout Configuration
Number |Manual Row 5 Column + Total

e
Scope | AFG | DMM 5 > | DMM DMM | |Scope DMM G | DMM
P

7

Scope | AFG | DMM | | Scope DMM Scope DMM | |Scope DMM | |Scope DMM

P PWS

DMM 5 5 | DMM G | DMM DMM G | DMM

AFG | DMM i DMM | |Scope | AFG | DMM AFG | DMM DMM | |Scope DMM DMM
| pws | | Pws

31

DMM 5 5 | DMM AFG | DMM AFG | DMM G | DMM DMM G | DMM

Figure 73: Number the benches manually

Make sure you don’'t number two benches with the same digit, or the following warning
pops up.

Tekironix TekSmartiab™ Home ing Administrator

Bench Lab Layout Configuration
Number s ] ¢ Caolumn

5 | DMM

Figure 74: Two benches numbered the same
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You can click Apply in the upper right corner of the page to apply the settings.

A dialog box for you to confirm the setting is popped up. Click Yes to complete the lab
configuration.

Centralized Instrument Configuration

You can configure the instruments and then distribute the settings to up to 100 benches.
Configuring Instruments

Take the following steps to configure the instruments:

1. Click Configure Instrument pane on the home page. The following figure is
displayed.

< Back  Status Unselected [T ] Selected Configure succeed Configure fail Unselectable

Bench Selection | 1 2 3 4 5 6 7 8 9 10 " 12 (;\J Capture

Figure 75: Configure instruments
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2. Click the icon of an instrument to select it, and the following figure is displayed.

< Back  Status Unselected [ ] Selected Configure succeed Configure fail Unselectable

Bench Selection | 1 2 3 4 5 6 7 8 9 10

= =
V-Scale Al V-Scale V-Scale
V-Position i |= V-Position

V-Position

Figure 76: Instrument selected

3. Set the parameters of the instrument selected.

N
(v) | Capture

Mode

Default Setup
Autoset
Logic Analyzer

Help Everywhere

Trigger
Source ~ Type

Slope v Level

NOTE: If you tick Default Setup, the instrument will be reset. Make sure you leave all

the parameters unconfigured.

If you tick Default Setup and configure some parameters, the instrument will be reset

and then the parameters will be configured.

NOTE: The parameters that can be set are based on the first such instrument
connected to the software. For example, if the first oscilloscope detected by the
system is two-channeled, the parameters for CH3 and CH4 cannot be configured.
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4. Click the white arrow on the right side of the Bench Selection bar to collapse it,
and the following figure is displayed. The numbered bench icons in blue is
selectable.

< Back  Status Unselected [ | Selected Configure succeed Configure fail Unselectable

Bench Selection

lf:j:\ Capture

All

L ]
™y Inverse

Logic Analyzer

Help Everywhere

Trigger

Source

Slope

Vertical & Horizontal

CH2 Horizontal

V-Scale V-Scale il V-Scale H-Scale

V-Position . - V-Position V-Position H.Position

Figure 77: Select bench

5. Select the bench icon and click Apply on the upper right corner of the page, and
the following figure is displayed. The numbered bench icon displayed in green
means the bench is successfully configured. If the icon turns red, select the
bench and repeat the configuration. If the icon stays red, please check the cable
connection, and then restart the instruments and TBX3000A. If the fault is still not
cleared, please perform a self-check of the instrument by referring to the
instrument user manual.

< Back Status Unselected [ | Selected Configure succeed Configure fail Unselectable

Bench Selection

EEEEEEE" 12 13 14
1 19 ZOE@@ Al

L]
33 34 35 36 37 38 39 40 ata Inverse

(f:jj Capture

Logic Analyzer

Help Everywhere

Vertical & Horizontal
CH1 Horizontal

V-Scale V-Scale V-Scale = V-Scale H-Scale

V-Position - V-Position - V-Position V-Position

H-Position

Figure 78: Bench configured
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6. You can also click Capture to get the configurations from a configured bench to
distribute to other benches.

NOTE: If two of the same instrument types are placed in the same bench, the
configuration of one instrument will be applied to the other.

It is recommended that the same instrument types that are connected to the system are of
the same series, or even the same model. For example, if the system already have
configurations for CH3 and CH4 for oscilloscope, the configuration won't succeed if one of
the oscilloscope that is connected to the system is a two-channel oscilloscope.

Firmware Upgrade
Take the following steps to upgrade the firmware:

1. Select Setting -> Firmware/Courseware Update on the menu bar. The
following figure is displayed.

Tektronix TekSmarilab™ Home Setting Administrator About

Status Unselected Selected Configure succeed Configure fail Unselectable

Bench Selection = 1 2 3 4 5 [ 7 8 9 10 M 12 =)

Firmware / Courseware Upgrade

Figure 79: Firmware upgrade

Choose the instrument type
Choose Firmware.

Choose the upgrade file.
Click Apply.

ok~
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Centralized Instrument Monitoring

Click the lab information area on the main (Home) page. The following figure is dlsplayed

< Back

Lab Overview

Bench Status i Offline Instrument Status Working Error Offline

AFG | DMM DMM S(‘OP AFG DMM S
PWS PWS PWS

12

9 10 5
Scopél AFG | DMM  SCOPE AFG | DMM Scopél AFG | DMM SC()P AFG | DMM 05'?1=_l AFG | DMM SC()P AFG DMM scoPEi AFG | DMM
PWS | PWS | PWS | PWS | PWS | PWS PWS |

17 18 19 20 pal 22 23

SCOPA AFG | DMM  SCOPE AFG | DMM scopé AFG | DMM scop‘ AFG | DMM SC()PA AFG | DMM smpé AFG | DMM scoPEi AFG | DMM  SCOPE AFG | DMM
PWS ‘ PWS PWS ‘ PWS | PWS ’ PWS ' PWS | PWS
L I 1 ; 1 1 ! 1

25 26 27 28 31 2

o — e S 5 — | — ek - = )
SCOPE] AFG |DMM SCOPE AFG | DMM SCOPE AFG | DMM  SCOPE AFG | DMM SCOPE AFG | DMM SCOPE AFG | DMM  SCOPE AFG | DMM SCOPE AFG | DMM
PWS ‘ PWS | PWS | | PWS | | PWS | PWS | PWS |

35 36 3 38 39 < 40

33 34 3] 6
SCOPE DMM SCOPE AFG | DMM SCOPE AFG | DMM SCOPE AFG | DMM SCOPE AFG | DMM SCOPE AFG | DMM SCOPE AFG | DMM
o == - e

Figure 80: Lab overview

The status of the bench and instruments are represented by different colors, as explained
in the status bar in the upper part of the page. For example, in the above figure, bench 1
is online, and the four instruments of bench 1 are working.
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You can click the bench to enter the bench page and monitor the instruments, the
following figure is displayed.

Bench1

Waveform Mode

Square ¥ Confinuous v
Frequency Am

1 MHz 1\

3 DMM:MODEL 2100,1 4 PWS: 2231 0 97020013

Default Setup Default Setup

Output
16 uA

-58.862uVDC

19.074 UA

Measurement Dcv 28
Output

Range Auto / 0A

Set 3A

Figure 81: Bench page

For the MDO3000 oscilloscope, you can switch between two modes: Scope (oscilloscope)
and SA (spectrum analyzer), as highlighted in the above figure.

You can monitor and control an instrument in detail by clicking the expanding icon
(highlighted in yellow box) in the upper right corner on the instrument pane.
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Using an oscilloscope as an example, the following page is displayed after you click the
expanding icon. If you want to go back, click the restore icon in the upper right corner.

Figure 82: Oscilloscope page

Bench1

AT

Logic Analyzer Default Sefup  AutoSet ¥  Single Run /

Cursor Enable
Disable

Source  CHit wiode  Off

Measuremert
CH1 ~ Frequency
CH2 ~ Period

Trigger
Source  CH1 ~ Type Edge

Slope Rise v level 0V

. Vertical & Horizontal

oC vi1x v oc

Horizontal
. | V-Scale 500 mV Al V-Scale 500 mV V-Scale V-Scale

H-Scale 400ns

. | V-Position 1V &= V-Pasition -1.05V + - V-Position V-Position H-Pasition 05

If you select Waveform, the waveform is displayed in real-time on this page. If you select
Screen, a snapshot of the waveform on the actual instrument is displayed here. You can
right-click on the waveform to save it. You can click Screen again to take another
snapshot.

You can disable Autoset on the upper right side of the page to have the students practice
setting parameters manually for the experiment. The Autoset button is displayed in gray if
you disable the function. If you enable the function, the Autoset button is displayed in
blue. You can click the button to execute the auto setting.
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As shown in the following figure, you can set the parameters for the waveforms in the

Vertical & Horizontal part of the page.

< Back

Bench1

1 Scope:MDO3102,No_Serial

Waveform Screen Help Everywhere Logic Analyzer

Vertical & Horizontal

[ crit__ JECRRER o
V-Scale 500 mV V-Scale 500 mV V-Scale Al V-Scale

V-Position 1V V-Position -1.05 V 5= V-Position V-Position

Figure 83: Vertical & Horizontal settings

Default Setup ~ AutoSet ¥  Single Run /
Cursor

Source CH1 v Mode Fime -

Measurement
CH1 ~ Frequency v 999.933 kH:
CH2 ~ Period v 1us

Trigger

Source  CH1 v Type Edge <

Slope  Rise v Level 0V

Horizontal
H-Scale 400 ns A v
H-Position 0s

You can either input values into the boxes or click arrows or plus and minus symbols to
set the parameters. In addition, the highlighted number 1 in yellow, number 2 in blue
represents the V-position of the two channels; the highlighted yellow arrow represents
trigger level. You can drag these symbols to change the values directly.

For the channels, DC is the mode of coupling, and 1X is the value for attenuation.
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As shown in the following figure, you can also use cursors for measurements on this

page.

< Back

1 Scope:MD0O3102,No_Serial

Waveform Screen Help Everywhere

Vertical & Horizontal

V-Scale 500 mV V-Scale 500 mV
V-Position 1V 4 | = V-Position -1.05V

Figure 84: Cursors

Use these steps:

Bench1

V-Scale
V-Position

Logic Analyzer

V-Scale
V-Position

1. Select the Source and Mode in the Cursor area.

2. Ifyou select Time for the mode, cursors “a” and “b” are displayed on the
waveform. Move the cursors and the measurement result is displayed
automatically in the box at the upper right corner of the waveform display.

Default Setup ~ AutoSet ¥ Single Run /
Cursor

Source CH1 v Mode Fime -

Measurement
CH1 ~ Frequency v 999.933 kH:
CH2 ~ Period vi1us

Trigger
Source  CH1 v Type Edge v
Slope Rise v Level OV

Horizontal
H-Scale 400 ns A v

H-Position 0's
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Asset Management

You can select Administrator -> Asset Management on the menu bar to manage the
instruments. The following figure is displayed.

Tektronix TekSmartlab™ Home Setting Administrator About

Asset Management

Start 2016-04-11 =] Stop 2016-04-21 =}

Bench No Model Number Query

S Mol umoer e unoer bty e~
21 -2 1 1 3

2016-04-20 10:00:04 | TBS 12028

|cot0a60
|cooas4
018001
C046804
080001
C048084

800101

Cog0014

|cota201

3 2016-04- 5 6 ] 046014

19 16:00:07 2 2000.46:14 I | coz0014

Figure 85: Asset management

You can set the parameters and then click Query to acquire the information about the
instruments. Then you can click Export to export the result as an Excel document.
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Lab Teaching Flow Management

68

This section describes how theTekSmartLab helps optimize lab teaching flow.

Create and Select an Exercise

As shown in the following figure, you can click the plus symbol in the course information
area to create a new course. The dialog box pops up for you to input the information.

Figure 86: Create a new course

Tektronix TekSmarilab Home Setting Administrator About

TekSmartLab

Create a new exercise

=+ Instructor Tektronix

Course Scope tutorial Instructor Tektronix

Course Scope tutonal
Exercise  Rise and fall time

Exercise

Normal
Error

Disconnected

Configure

Instrument

Test Report
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You can input the name of the instructor, the name of the course, and the name of the
exercise, and then click Ok to save the exercise, as shown in the following figure.

Tektronix TekSmartlab™ Home Setting Administrator About

TekSmartLab

Create a new exercise

#+ Instructor Tektronix

Course Scope tutorial Instructor Tektronix

Course
Exercise  Rise and fall time Configure

[SCEE Demo Instrument

4 Normal
0 Error

156 Disconnected Test Report

Figure 87: Create a new exercise
You can select an existing exercise, as shown in the following figure.
Telitronix TekSmarilab™ Home Setting Administrator About

TekSmartLab

+ Instructor Tektronix

Saved Confi Exercise Material
Course Scope tutorial g

Exercise  Rise and fall time meas -
|Rise and fall time measur

Instrument
Peak to peak measureme Report Template
Demo

Configure

Total Instruments
Normal
Error

Disconnected Test Report

Figure 88: Select an existing exercise

NOTE: You can delete an exercise by clicking Administrator -> Exercise Management.
Only the administrator has the access for deleting exercises.
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Savelrecall instrument configuration

This function allows you to save instrument configurations, or to recall instrument

configurations.

You can click the Saved Config area on the home page to configure the instruments and
then save the settings. The following figure is displayed.

< Back  status
Bench Selection = 1 2 3

AFG
CH1 Output

Waveform
Frequency

Scope

Unselected [ | Selected

Configure succeed Configure fail Unselectable

5 6 7 8

7 12 Output
2 Defaut Setup

Measurement

Mode

Amplitude Offset

Defaulit Setup

Output
Set Voltage
Set Current
Output
Set Voltage
Set Current

Output
Set Voltage
Set Current

H-Scale

Figure 89: Configure the instruments

As shown in the above figure, all the instrument types that are supported by the software
are displayed here. You can configure all the instrument types here as long as you tick the
box in the left upper corner of each instrument type.
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NOTE: The differences between configuring instruments on the home page and here are
that:

o The configuration can be done to four instrument types at the same time in this
page.

e The configuration can be saved here and recalled for later use.

NOTE: If two of the same instrument types are placed in the same bench, the
configuration of one instrument will be applied to the other.

You can set the parameters for the instruments as shown in the following figure.

< Back  status Unselected [ | Selected Configure succeed Configure fail Unselectable

Bench Selection = 1 2 3 4 5 6 7 8 9 10 " 12

AFG O DMM

CH1 Output [ONIEE] ~ CH2 Output [OFF
utpul Liel Default Setup

Measurement

Waveform Mode

s v Continuous ~
Frequency Amplitude Offset
1kHz 1Vpp ov
Scope

Default Setup
Output

Set Voltage
Set Current
Output

Set Voltage
Set Current
Output

Set Voltage
Set Current

CH2.

2 H-Scale
200mV 200 mV 400 us

Figure 90: Configure the instruments

NOTE: The parameters that can be configured are based on the first instrument of the
type that is detected by the system.

You can also select a preconfigured instrument in another bench and click Capture to
acquire its configurations to apply to the instrument you want to configure. The waveform
of the oscilloscope and arbitrary function generator will only be displayed when you click
Capture.

You can click Save to save the configuration for future use.

You can also select other benches to apply the configurations.

4



TekSmartLab™ TBX3000A, TSL3000B User Manual

Student Access

This chapter introduces features that this software provides for students to access the
experiments on a webpage.

Generate QR Codes for Benches

The server generates a webpage for each bench for students to access the exercise. The
students can log in the webpage by scanning the QR code generated for the webpage or
the IP address.

Take the following steps to generate QR codes for the benches:

1. Select Setting -> General Information on the menu bar to generate QR codes
for the benches, as shown in the following figure.

Tektronix TekSmartlab™ Home Setting Administrator About

General Information

Lab Information

Lab Name TekSmartLab

QR Code Generation

WiFi LAN 192168166

Bench NO. 1

Width(Unitmm) 240

hitp//192.168.1.66/login.aspx?deskid=1

Print

Figure 91: Generating QR code

2. Set the server IP in the TekSmartLab network. You can choose WiFi, LAN, or
input the IP manually.

NOTE: The server should be set with static IP so that the address for each webpage
won't change.
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NOTE: If computers for students installed on the benches and TekSmartLab server
belong to the same campus network, then set the server IP as the IP address in the
campus network. Thus, the computers on the benches are able to access the bench-
specific IP address distributed by the server.

3. Input the bench number. If you want to generate the QR codes in batch for
benches, tick Batch, and then input the bench numbers.

4. Input comments if necessary.

5. Click Print under the QR code preview to generate the codes.

You can paste the printed QR codes on their correspondent benches in the lab.
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Accessing the Webpage
Students can take the following steps to access the bench webpage:

1. Connect your smart phone or computer to the TekSmartLab network. If you are
using the computer on the bench, and the bench and server are connected to the
campus network, then you are not required to be connected to the TekSmartLab
network.

2. Taking bench 1 as an example, scan the QR code, or input the address to log
onto the bench webpage. The following figure is displayed.

_Tektronix |

Lab Name: TekSmartLab
Bench: 1

Course Name: Scope tutorial I
Exersise: Rise and fall time
measurement

Student Name:

Student ID:

[Remember me
Scope Snapshot

Figure 92: Log in the bench webpage

3. Input your name and ID to log in the webpage.

NOTE: Your Student ID should be unique, whereas Student Name does not need to be
unique.

You can also take a snapshot of the oscilloscope screen by clicking Scope Snapshot on
this page.
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Exercise Material Sharing

In the course information area, you can click the Exercise Material area on the main
(Home) page to share the exercise material with students. The following figure is
displayed.

Exercise Material

Introduction:
TekSmartLab server can work as an FTP server,you can add the material here so that the students are able to download it from the web page of their devices.
The material can be in the format of ppt, word, video etc.

ome |mpe sa  |Tass |

TBS1000B-EDU-Oscilloscope-DataSheet-1_0.pdf 8/27/2014 11:20:44 .. | pdf 777537 Bytes

Figure 93: Edit exercise material

On this page, you can add or delete exercise material on the server.

Exercise Material

Introduction:
TekSmartLab server can work as an FTP server,you can add the material here so that the students are able to download it from the web page of their devices.
The material can be in the format of ppt, word, video etc.

iane e e e R,
ST_AFG_Cursor_Rise-Fall-Time_Measurement pdf 4/20/2016 11:28:40 pdf 76414 Bytes
TBS1000B-EDU-Oscilloscope-DataSheet-1_0.pdf 8/27/2014 11:29:44 pdf 777537 Bytes

Delete

Figure 94: Add or delete exercise material
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On a student’s smart device, as shown below, students can download the exercise
material to their devices.

[{=]|Test Report ISR IE] 1]
=7

I ~| ST_AFG_Cursor_Rise-Fall-Time_Measurement.p

I, - TBS1000B-EDU-Oscilloscope-DataSheet-1_0.pdi

Figure 95: Download exercise material
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Test Report Editing

In the course information area, you can click Report Template button to import a test
report template to the server. You can create a test report template by using Microsoft
word (only .docx format is supported) and then import the .docx file to the server, as
shown in the following figure.

Test Report Template

Introduction:

Report template can only be in the format of .docx created by Microsoft Word. It will be transformed to HTML when it is loaded in the web page on students' devices.
When the template in word is transformed to HTML, only the texts and images are kept. You can click Preview to see the uploaded template in HTML or refer to the
example shown below.

Test Report Template C:\ i Sma >\labs\Rise and fall time

O Preview

Example
Report template in *. docx format Report template in HTML format

o Text and image can be saved. e Text and image can be saved

)
REVOLUTIOM:ERING. S04 Toldronbx
e o & e h [—="]

9
REVOLUTIOM:gpiNG. ¥ et ot

@ Header and footer cannot be saved. ® Header and footer cannot be saved
e e D e e
saved unless it is changed to be an image. 9 g

a3 ()t

Figure 96: Importing test report template

The template is transformed into an HTML file once it's imported to the server. You can
click Preview to see how it is displayed in HTML format.

On a student's smart device, as shown in the following figure, students can create a new
test report by clicking New Report.

[{=|Test Report

New Report

Y& Material

Figure 97: Create a new test report
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When you create a new test report on your device, the defined template is automatically
loaded, as shown in the following figure.

[[=|TestReport  j& Material

LYW Scope Image m

A ~ JAl - FontFamily~ FontSizes~

B 7 - -

o Text and image can be saved
&

SERING. 3 M-

®  Header and footer cannot be saved
® Inserted equation, as below, cannot be
saved unless it is changed to be an image

hittps=/1:2if10stAT - stReRoIALI: o Tzis P | M

Figure 98: Create a new test réport

You can edit the report and insert the test result. For example, click Scope Image to
insert the oscilloscope snapshot into the test report, as shown in the following figure.

[(=|TestReport  j& Material ’\i

e Text and image can be saved
&

% e
SERING.

® Header and footer cannot be saved
® Inserted equation, as below. cannot be
saved unless it is changed to be an image

Figure 99: Scope snapshot inserted
After you are finished editing the test report, you can click Submit to submit it.

You can also download the test report locally to edit it in a Word file.
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You can click Test Report on lower right side of the home page to check a student’s test
reports. The following figure is displayed.

Test Report

Start Thorsday, April 21, 2016 =] Stop [Thursdey, April 21, 2016

Instructor Course

Exercise Bench NO.

Student Name Student ID Query

Bench No. | Student Name Student ID

Tektronix Scope tutorial Rise and fall ime measurem Tom 23456
Tektronix Scope tutorial Rise and fall ime measurem... |2 Jacky
Tektronix Scope tutorial Rise and fall ime measurem
Tektronix Scope tutorial Rise and fall ime measurem

Tektronix Scope tutorial Rise and fall time measurem... |5 ssie Chang
2016-04-21 10:31:08 | Tektronix Scope tutorial Rise and fall time measurem... |6 Mike Edwald

2016-04-21 10:32.06  Tektronix Scope tutorial Rise and fall time measurem.. Wang Tian
2016-04-2110:28:47 | Tektronix Scope tutorial Rise and fall time measurem. Tina Tang
10:29.09 |Tektronix Scope tutorial Rise and fall time measurem Gary Wee
Ktronix Scope tutorial Rise and fall time measurem Chelsa Tang
Tektronix Scope tutorial Rise and fall time measurem Marry Ying
Tekironix Scope tutorial Rise and fall time measurem Patrick Ma
Tektronix Scope tutorial Rise and fall ime measurem... |13 Bryce Li
Tektronix Scope tutorial Rise and fall time measurem Richeal CHEN
Tektronix Scope tutorial Rise and fall ime measurem... | 15 Jacky Wang
Tektronix Scope tutorial Rise and fall time measurem... | 16 Tony Wu
2016-04-2110:31:08 | Tekironix Scope tutorial Rise and fall ime measurem Harry Ji

Detail Export Report List Export Report Files

Figure 100: Query test report
You can input the time next to Start and Stop and click Query to get the students’ report.
You can double-click a report to check it, or choose a report and click Detail to check it.

You can click Export Report List to export the query result in an Excel document. You
can click Export Report Files to export all the text reports.

You can click Delete to delete the selected report.
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Case Study

Set up a TekSmartLab Network System

80

Introduction

In order to ensure the stability and security of running the TekSmartLab solution, we
should set up an independent network other than taking advantage of the existing
network, for example, the campus network. If the lab server is connected to the campus
network, we should add a network card or a USB WIFI dongle for TekSmartLab network.
Thus the server is working simultaneously with the TekSmartLab network and the campus
network.

The following figure illustrates that the server is connected to the TekSmartLab network
through Wi-Fi, and also connected to the campus network through LAN.

Bench 4

Campus

) Router Lab Server N etWO rk
cac TBX3000A TSL3000B

o S\

- - TekSmartLab

Instruments on one bench Network

Figure 101: TekSmartLab network

You can set up the TekSmartLab network wireless, through cables, or a mix of both
according to the actual lab requirements.

NOTE: Make sure that TBX3000As on each bench are in the same network with the
server at all times, which means that you can ping the IP address of the TBX3000As on
the server successfully.

TekSmartLab User Manual



TekSmartLab™ TBX3000A, TSL3000B User Manual

Configure the Network

To set up a wireless network:

Configure the wireless network using these settings:
o  Wireless network mode: 2.4GHz, 802.11n

o Set the number of the Max. Associated clients larger than the number of
devices that are connected to the network. For example, if the network is
connected to1 lab server, 20 benches through TBX3000A, and 20 smart
phones from students, set the number of Max. Associated clients larger than
41.

o WIFI signal level: >= -50dBm (recommended)
o WIFI signal to noise ratio: >=35dB (recommended)
For the wireless equipment;

o Ifthe number of benches is larger than 15, it is recommended to use corporate
grade router (such as TP-LINK TL-R600VPN) plus Access Point devices (such
as TP-Link EAP120) to form a network. 1 AP for every 15 benches is
recommended.

o Ifthe number of benches is equal to or smaller than 15, a corporate grade
router (such as TP-LINK TL-ER604W) is enough for the network.

NOTE: The WIFI coverage will vary by cases. Please consult with your IT
department or the router manufacturer for more information.

If you are going to set up a wired network, make sure that every bench has an IP
address. TBX3000A supports both dynamic IP and static IP.
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Install TekSmartLab on the lab server
Refer to Installing TSL3000B to install TSL3000B properly on the lab server.

Note that the lab server should be set with a static IP address, and the software should be
started only after the lab server is connected to the TekSmartLab network.

Configure the TBX3000A

Connect the TBX3000A

1. Install the USB-WIFI dongle on each TBX3000A

2. Connect the instruments on each bench to the TBX3000A using USB cables,
and then power the instruments on, as shown in the following figure. The figure is
an example of only two instruments connected to the TBX3000A on the bench.

USB cables to connect
instruments to TBX3000A

T}

Figure 102: Connecting TBX3000A
Log onto the TBX3000A Configuration Page
There are two ways to log onto the TBX3000A configuration page on a computer:
®  Connecting the TBX3000A directly to a computer
¥ Connecting the TBX3000A to a router
Connect the TBX3000A directly to a computer

Connect the TBX3000A to a computer as shown in the following figure:
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. LAN cable

Figure 103: Connect the TBX3000A directly to a computer

Set the LAN connection parameters of the computer (with path Control Panel - > Network
and Internet -> Network and Sharing Center for Win7 operation system) according to the
figure in the below:

3. Internet Protocol
. Version 4 (TCP/IPv4)
e Properties

8 L o P D s e

4, Select “Use the
following IP address” and
input the parameters

Figure 104: LAN configuration

The LAN parameters are set as follows:

IP address :192.168.1.66

Subnet mask: 255.255.255.0

Default gateway: 192.168.1.1

Enter the IP address 192.168.1.101 in your browser, and then configure the TBX3000A.
Connect the TBX3000A to a router

Connect TBX3000A to a router as shown in the following figure:
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. LAN cable

Router WIFI or LAN cable

Figure 105: Connect TBX3000A to a router

Make sure the computer is connected to the ‘school_lab_1" network. If the computer is
successfully connected via WIFI, you will see the network as shown in the following figure.

Wireless Network Connection ~
school_lab_1 Connected 1._“!
AuthorizedGuest :;“ A
TekSmartLab-Demo 1-_“!

Open Network and Sharing Center

<

Figure 106: Computer connected to ‘school_lab_1" network

NOTE: The ‘school_lab_1’ network is generated by the router.

Enter the IP address 192.168.1.101 into your browser, and the welcome page is displayed
as shown in the following figure. Then configure the TBX3000A.

& hitp://192.168.1101/

Welcome Page

Welcome Page

Instrument Model: TBX3000A
LAN Ci
Firmware Revision 200
WIFt Confistration Serial Number co10877
Set Password LAN Connection Status Connected
WIFI Connection Status Disconnected
Host Name (FQDN): Bench1.local.

Figure 107: Welcome page
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Configure the TBX3000A for the wireless network

1. On the welcome page of TBX3000A, Select LAN configuration on the left side

to enter into LAN configuration page

Welcome Page

| LAN Configuration |

LAN Configuration

Hostname:

Bench1

WIFI Configuration

Set Password

TCP/IP C Mode:

Manual

IP Address:

192.168.1.101

Subnet Mask:

2552552550

Default Gateway:

19216811

‘Connect Status:

Connected

Speed:

100Mbs

Figure 108: LAN configuration

2. Click Modify to enter into Modify LAN Configuration page. Input “admin” if
password is required.

Welcome Page

LAN Configuration

Modify LAN Configuration

TCP/IP Configuration Mode:

O Automatic
® Manual

WIFI Ci

Set Password

IP Address:

192.168.1.101

Subnet Mask:

255.255.255.0

Default Gateway:

192.168.1.1

Host Name:

‘Bencm

Figure 109: Modify LAN Configuration

3. Change the host name into BenchX, in which X represents the number of the
bench on which the TBX3000A is placed. The above figure uses Bench1 as an
example. Click Submit to finish. Note that the TCP/IP configuration Mode and
other settings should not be changed.

4. Click WIFI Configuration on the left side to enter into WIFI configuration page
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eb © hitp/1921681101/ - p-c ] @ WIFI Configurati :]—\ AT
WIFI Configuration
Welcome Page
AN Hostname: Bench1
TCP/IP Configuration Mode: Manual
WIFI 1P Add
Set Password Subnet Mask:
Default Gateway:
SSID:
Connect Status: Disconnected
Signal Intensity:
[ Modify ] [ Scan AP ]

Figure 110: WIFI configuration

5. Click Scan AP to search for the WIFI network, as shown in the following figure.

/[ http://192.168. 1. 101/ x

< QD4 [192.168.1.101 =
‘Welcome Page

WIFI AP List
SSID BSSID Swength Security
LAN Configuration
@ TekSmanLab-Demo 14:76:90:29:20:62 all WPAPSKITKIP
'WIFI Configuration
o : DanaherTM 68:BD:ABD275 A0 al WPA2-802 1WAES
©  AuthorisedGuest 68:BD-AB-D276 A4 al MNone £
@ AuthorizedGuest 68.BD-AB:D2.76:A2 a HNone
68:5D:AB:D2:76:A1 a WPAZ-802 1WAES
® CO:61:18:B04C:06 i WPA-PSK/MPA2-PSKIAES
I ®  school_lab_1 50:BD:5F:37:58:86 all WPA-PSKMIPAZ—PSWAE4 m
@ school_lab_2 50:BD-5F-37-68:10 al WPA-PSKMWPA2-PSK/AES
©  teksmartiab-lbj C0:61:18:80:53.00 ¥ Hone
@ ncheal-smartiab 52:BD'5F-53-B3 50 al None
DanaherTM B4:AM-EI1EMABO a WPA2-802 1WAES
Tektronix:
192.168.1. 101 fop-bin/ScanaP cgi s

Figure 111: Scan AP

6. Choose school_lab_1, and then click Apply.
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7. Ifthe ‘school_lab_1" network can only be accessed by a password, a prompt
pops up as shown in the figure below. Enter the password and click Connect.
Once connected, the WIFI indicator on TBX3000A will blink twice a time.

[y
[ httpeff192. 188.1.101]
< Q94 & [D192168.1.101 =
Wifi - config
Welcome Page
T ssID school_lab_1
WIFI Configuration Security Type WPAPSK ~
e Encryption Type AES -
PSK Key teksmartiab
[ Connect ] [ Back
'Ihklron/ix

Figure 112: Input password

8. Check the Host Name, SSID and Connect Status, and TCP/IP configuration
Mode is Auto as default.

© nitp:/192168.1.101

0+ || @ iR Configuration

WIFI Configuration

Welcome Page

Hostname: Bench1
TCP/IP Configuration Mode: Auto
IP Address: 192.168.1.150

LAN

WIFI Configuration

Set Password Subnet Mask: 255.255.255.0
Default Gateway 192.168.1.1

SsID school_lab_1
Connect Status: Connec ted

Signal Intensity Excellent

[ Modify ] [ ScnnAP]

Figure 113: WIFI configuration

9. If need to set the static IP address, click Modify. Enter “admin” if password is
required. Select TCP/IP Configuration Mode to be Manual, and set the IP
address, Subnet mask and Default gateway manually. Click Submit to finish.
Note host name should not be changed.
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Welcome Page

LAN C

Modify WIFI Configuration

WIFI Configuration

Set Password

Figure 114: Modify WIFI configuration

TCP/IP Configuration Mode:

Automatic
© Manual

IP Address:

192.168.1.111

Subnet Mask:

255.255.255.0

Default Gateway:

192.168.1.1

Host Name:

Bench1

10. Click Welcome Page, and the configuration is done as shown in the figure

below.

& nittp://192168.1.101,

Welcome Page

LAN Confi

TBX3000A

WIFI Configuration

Set Password

200

C010677

LAN Connection Status:

Connected

WIFI Connection Status:

Connected

Host Name (FQDN):

Bench1.local.

Figure 115: WIFI configuration finished

11. Disconnect the LAN connection of TBX3000A to finish the configuraiton.

12. Repeat the procedure to configure the TBX3000A on the bench and change its
host name as BenchX, in which X represents the number of the bench that
TBX3000A is placed.

13. After configuring the TBX3000As, they will be connected to ‘school_lab_1’
network automatically, and will be automatically recognized as the bench
configured by the TSL3000B software running on the lab server.

NOTE: The host name of TBX3000A must be changed on the LAN configuration

page.

Two TBX3000As cannot have the same host name, otherwise the later host name will
be displayed as “BenchX-2.local”, as shown on the welcome page below, and cannot

be recognized by the TSL3000B software.
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Welcome Page

Welcome Page

Instrument Model:

TBX3000A

LAN C

Firmware Revision- 200
WIFI Configuration Serial Number. co10877
Set Password LAN Connection Status: Connected

WIFI Connection Status:

Connected

Host Name (FQDN)

Bench1-2 local

Figure 116: Two TBX3000As with the same host name

Configure the TBX3000A for the LAN network

1. Select LAN Configuration on the left side and click Modify, as shown in the

following figure. Input “admin” if password is required.

@ hitp://1921681.101

£ - & || @ LAN Configuration

Welcome Page

LAN Configuration

Hostname: Bench1
TCP/IP Configuration Mode: Manual
AT IP Address: 192.168.1.101
Set Password Subnet Mask: 255.255.255.0
Default Gateway: 192.168.1.1
Connect Status: Connected
Speed: 100Mbs

Figure 117: LAN configuration

2. Change the host name of the bench to which the TBX3000A is connected, as
shown in the following figure.

| ] | O
Modify LAN Configuration

Welcome Page

LAN Configuration et
TCP/P Configuration Mode: =

WIFI Configuration O Manual

Set Password JRiass |
Subnet Mask 17
Default Gateway: T‘“_m“—.
Host Name: I ‘Bencm l

Figure 118: Modify LAN configuration
3. Select Automatic next to TCP/IP Configuration Mode. Or you can select

Manual, then input the IP address, subnet mask, and default gateway.
4. Click Submit to complete the configuration.
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NOTE: After clicking Submit, the TBX3000A could be disconnected to the computer
that is used to configure the TBX3000A because the default IP address of the
TBX3000A is modified. To check the IP address and host name, you need to log in
the router configuration page.

Arrange the Bench and Lab Layout

90

This case supposes that there are four instruments placed in one bench: an oscilloscope,
an arbitrary function generator, a digital multimeter, and a power supply.

Arrange the bench layout
Take the following steps to arrange the bench layout:

1. Click Setting -> Bench/Lab Layout Config and choose the Bench Layout
Configuration tab.
2. Choose the four-instrument layout, as shown in the following figure.

Bench Layout

Figure 119: Four-instrument bench layout

3. Choose the four instruments, as shown in the following figure.

Tektronix TekSmartlab” Home Setting Administrator About
Bench Layout Configuration Lab Layout Configuration
Bench Layout ==
1 Oscilloscope v 2 Ambitrary Function Generator
g CH 1 Output [1ON

»

Exémplé - Example

\

Multimeter v a4
Default Setup

-123.125 mV
Example Example

Measurement  DC V

Range 1000 V

Figure 120: Choosing instruments

4. Click Apply.
5. Click Yes to confirm the setting.
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Arrange the Lab Layout

In this case, there are 16 benches in 4 rows. The benches are numbered from left to right,
as shown in the following figure.

A & &
- &
- &

&)

—
w

R & & &

8- 8

i
i

Figure 121: Lab layout
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Take the following steps to arrange the lab layout:

1.

a0

Click Setting -> Bench/Lab Layout Config and choose the Lab Layout
Configuration tab.

Choose By Row next to Number.

Input 4 next to Row.

Input 5 next to Column.

Clear the middle column by double-clicking the benches, as shown in the
following figure.

Tektronix TekSmarilab” Home Setting Administrator About

6.

Figure 122: Arrange lab Iayot

Bench Layout Configuration Lab Layout Configuration
¢ Column 5 + Total

> | DMM G | DMM 5 | DMM |

5 | DMM

> | DMM G | DMM

5 | DMMm 5 | DMM > | DMM |

Click Apply to complete the setting.
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Centralized Instrument Configuration
1. Click Configure Instrument on the home page, the following page is displayed.

< Back  Status Unselected [| Selected Configure succeed Configure fail Unselectable

Bench Selection | 1 2 3 4 5 6 7 8 9 10

(+) [captire

Mode

Default Setup
Autoset
Logic Analyzer

Help Everywhere

Trigger
Source - Type

Slope v  Level

Horizontal
V-Scale V-Scale

V-Scale H-Scale
V-Position + - V-Position V-Position

Figure 123: Configure instrument

H-Position

2. Choose Scope in the left pane, the oscilloscope configuration page is displayed
on the right.

Click the white arrow to hide the icons of the instruments.

Tick Default Setup.

Click on CH2 to disable it, and its color will turn grey.

Choose Disable next to Autoset, as shown in the following figure.

ook w

< Back Status Unselected |:| Selected Configure succeed Configure fail Unselectable

Bench Selection | 1 H 3 4 5 6 7 8 9 10 (:‘ Capture Apply

Scope Mode Scope

Defautt Setup
Autoset Disable
Logic Analyzer

Help Everywhere

Trigger

Source

Slope

Vertical & Horizontal

- CH2

Horizontal
V-Scale V-Scale

V-Scale V-Scale H-Scale

V-Position + - V-Position + - V-Position V-Position

H-Position

Figure 124: Configure oscilloscope
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Monitoring a Bench

94

8. Click the white arrow to see all the benches, as shown in the following figure.

Bench Selection

=%, Inverse

Figure 125: Bench selection

. Choose all the benches displayed in blue, or click All to choose.
10. Click Apply to distribute the configuration to the chosen benches. The configured
benches will be displayed in green.
11. Press the Autoset button on the oscilloscope, and you will get a message that
“Autoset is disabled.” on its screen.

Click the lab information area on the main page. You will have an overview of the lab.

Checking the Status of an Instrument

Using bench 1 as an example in the following figure, all the four instruments are
connected and online.

Figure 126: Instrument status

If you disconnect the oscilloscope from TBX3000A on bench 1, or turn its power off, the
scope will be displayed in grey.

Figure 127: Scope not online
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If you connect the oscilloscope to TBX3000A or turn its power on, the scope will be
displayed in green again.
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Monitoring a Bench

You can click the bench to enter the bench page and monitor the instruments, the
following figure is displayed.

Bench1

Lstaut Sehp

-39.809uVDC

wement Dov

Figure 128: Monitoring a bench

If you turn the horizontal scale knob of the oscilloscope on bench 1, you will see that the
waveform is also changed here.

You can monitor and control an instrument in detail by clicking the white box in the upper
right corner on the instrument pane. Using the oscilloscope as an example, the following
page is displayed after you click the white box.

Bencht

Default Sefup ~ AufoSet ¥ Single Run /
e CH1 ~  Moc

Measurement

Figure 129: Monitoring an oscilloscope

If you select Screen, a snapshot of the waveform on the actual instrument is displayed
here. You can right-click on the waveform to save it. You can click Screen again to take
another snapshot.
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Controlling an Instrument from the Server

In the lab, if a student requires some assistance from the instructor, the instructor is able
to access the instrument from the server to help the student.

Select Waveform, the waveform is displayed in real-time on this page, as shown in the
following figure.

Bench1

o

Figure 130: Monitoring an oscilloscope

Modify V-scale of CH1 on this page, the V-scale parameter is changed on the
oscilloscope accordingly. The waveform on this page and on the monitor of the instrument
are both changed.

If you place the mouse on top of the yellow arrow 1, an upward arrow and a downward
arrow are displayed. Right-click to select them and move them. The V-position parameter
on the oscilloscope is changed, as well as the waveform, as shown in the following figure.

Bench1

Figure 131: V-position changed
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Asset Management

On the home page, you can select Administrator -> Asset Management on the menu
bar to manage the instruments.

You can set the parameters by inputting time next to Start and Stop, and then click
Query to acquire the information about the instruments, the following figure is displayed.

Tekitronix TekSmarilab™ Home Setting Administrator About

Asset Management

Start 2016-04-11 = Stop 2016-04-21 [=]
Bench No Model Number Query

Model Number Serial Number Utiity Tme(min) &
1 3]

| 78S 12028
31 |4 c le

1

|2016-04-20 09:56:48 2016-04-20 10:00:04

19 16:09-17
013
19 16.0007

Figure 132: Query the instruments

All the instruments that are connected to the TekSmartLab server are displayed, including
their bench number, serial number, models, and working duration.

Then you can click Export to export the result in the format of Excel.

Create a New Exercise

On the home page, you can click the plus symbol on the left upper corner of the course
information area to create a new exercise. The following figure is displayed.

Create a new exercise

Instructor Professor A

Course Analog circuit

Exercise Demo|

Cancel

Figure 133: Create an exercise
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You can input all the information and then click OK.

Now you can go to the exercise by selecting the instructor, as shown in the following
figure.

Teltronix TekSmarilab™ Home Setting Administrator About

TRIAL

=+ Instructor Tektranix
Tektronix
Professor A

e N Saved Config Exercise Material
Course  geope tutorial

Exercise  Rise and fall time meas - Configure

Instrument
Report Template

Total Instruments
Normal
Error

Disconnected

Figure 134: Selecting an instructor

Instrument Configuration Saving/Recalling

TekSmartLab User Manual

Take the following steps:

1. Select Tektronix next to Instructor.

2. Select Scope Tutorial next to Course.

3. Select Rise and fall time measurement next to Exercise.
4. Click the Save Config area.

NOTE: You may find that AFG and Scope are already selected with some
parameters configured. You can directly apply these parameters or configure them by
the following steps.
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5. Select the AFG and Scope by ticking the white box in the left upper corner of
each area, as shown in the following figure.

< Back  status Unselected [ | Selected Configure succeed Configure fail Unselectable

Bench Selection 1 2 3 7 8 9 10 " 12

AFG O

CH1 Output CH2 Output [OFF 2
. 2 Default Setup

Measurement

Waveform Mode
Sine Continuous ¥

Frequency Amplitude
1 kHz 1Vpp

Scope

Default Setup
Output

Set Voltage
Set Current
Output

Set Voltage
Set Current
Output

Set Voltage
Set Current

H-Scale

200 mV/ 400 us

Figure 135: Select Scope and AFG
6. Configure the AFG and Scope, as shown in the following figure.

< Back  status Unselected [ ] Selected Configure succeed Configure fail Unselectable

Bench Selection = 1 2 3 4 5 6 7 8 9 10 1" 12

AFG

CH1 Output ( Output  |OFF
¢ L L Default Setup

Measurement

Waveform Mode

Sine Continuous v
Frequency Amplitude

1 kHz 1Vpp

Scope

Default Setup
Output

Set Voltage
Set Current
Output

Set Voltage
Set Current
Output

Set Voltage
Set Current

H-Scale
200mV  200mV 400 us

Figure 136: Configure Scope and AFG

7. Click Save after the configuration. This configuration is saved under this
exercise.
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8. Click the white arrow to see all the benches, as shown in the following figure.

< Back  status Unselected [T ] Selected Configure succeed Configure fail Unselectable

Bench Selection

= Inverse
mim

Waveform Mode
Sine Continuous ¥

Frequency Amplitude
1kHz 1Vpp

Scope
Default Setup
Output
Set Voltage
Set Current
Output

Set Voltage
Set Current

HScal oups
-Scale Set Voltage

200 mV 400
m L& Set Current

Figure 137: Apply to other benches

9. Select the benches to be configured
10. Click Apply to apply the configuration to all the selected benches.

Student Access

This case uses bench 1 as an example. The student visits the webpage of bench 1
through the computer on bench 1 or his or her own smart device.
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Bench webpage
For the instructor to create access for the bench webpage, take the following steps:

1. Select Setting -> General Information on the menu bar, as shown in the
following figure.

Tektronix TekSmartlab™ Home Setting Administrator About

General Information

Lab Information

Lab Name

QR Code Print Preview

Bench1

Width(Unitmm) 240

hitp:/192.168.1.66/login aspx?deskid=1

Print

Figure 138: Generate bench webpage

2. Input the server IP:

o [fthe server and the student computer on the bench are connected
to the same campus network, input the server IP address in the
campus network.

o [fthe server and student’s smart device are both connected to the
TekSmartLab network, input the server IP address in the
TekSmartLab network.

3. Select Single. The QR code and web address for the bench are shown in
the QR Code Print Preview area.

For the student to access the webpage, you can:

o Type in the address in the computer web browser.
e Scan the QR code with the smart device.
o Type in the address in the web browser of the smart device.
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The following figure is displayed after you type in the address in the computer web
browser. You may bookmark this page.

m [ nitp://1921681.66/1ogin esprideskio=1
p

File Edit View Favorites Tol

Lab Name: TekSmartLab
Bench: 1
Course Name: Scope tutorial
Exersise: Rise and fall time measurement
Student Name:

Student ID:

[CRemember me
Scope Snapshot

Figure 139: Visiting bench webpage

Sharing Exercise Material

In the course information area, you can click Exercise Material button to share the
exercise material with students. The following figure is displayed.

Time_Measurement pdf

Figure 140: Share exercise material
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You can click Add to add one or more files to share with the students, like instrument
reference manual or exercise videos, as shown in the following figure.

ST_AFG,

TBS1000B-

Delete

Figure 141: Add exercise material
For the student to access the exercise material:

1. On the bench webpage, input your name and ID.

NOTE: Your student ID should be unique, whereas the student name does not need
fo be unique.

2. Select the Material tab, the exercise materials are displayed as shown in the
following figure.

- -
m | fé http://192.168.1.66/ CoursewareView.aspx

- File Edit View Favorites Tools Help

=

I)\ ST_AFG_Cursor_Rise-Fall-Time_Measurement pdf

I)\ TBS1000B-EDU-Oscilloscope-DataSheet-1_0.pdf

Figure 142: Access exercise material

3. Select the file and click Download.
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Test Report Editing

For an instructor to edit the test report template:

1. In the course information area, click Report Template button. The following
figure is displayed.

Test Report Template

Introduction:

Report template can only be in the format of .docx created by Microsoft Word. It will be transformed to HTML when it is loaded in the web page on students' devices.
When the template in word is transformed to HTML, only the texts and images are kept. You can click Preview to see the uploaded template in HTML or refer to the
example shown below.

Test Report Template C: n Files (x86)\Tektr eLib\labs\Rise and fall time
g Preview

Example
Report template in *.docx format Report template in HTML format

1ot be saved

o Text and image can be saved. e Textand image can be saved
i

L |, REVOLTOERING S -
®  Header and footer cannot be saved- ® Header and footer cannot be saved
@ Inserted equation, as below, cannot be. ® Inserted equation, as below, cannot be

sved inises kit cha ohemi . saved unless it is changed to be an image

G+ )n:" ™Y kqn-k,
crar =Y ()

Figure 143: Edit report template

2. Click Preview to check the existing template.
3. You can also create your own template and click BN to import it to the
server. Only the *.docx file format is supported.
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For the student to edit and submit the test report:

1. Select Test Report tab on the webpage.
2. Click New Report, the following figure is displayed.

http://192.168.1 66/ Tes (2192168166

ﬂ g8 Edit View Favortes Tools Help

Create NewReport [

Report Name

Rise and fall time me x

OK Cancel

Figure 144: Create a new report

3. Click OK, the following figure is displayed. The report template created by
the instructor is loaded automatically.

O+ X ® EEZ S A-HE- Foramye Fomssse B/ T iT -

Test Report Template

® Instructor: Tektronix
® Courser: Scope Tutorial
® Exercise: Rise and fall time measurement

Student name:
Student ID:

OBJECTIVES
After. i

this lah everrice learner will he ahle ta

s px span Words: 289

Figure 145: Edit a new report

4. Edit the report by entering the name and ID, along with other content.
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5. Under Test Result, click Scope Image button to insert scope snapshot, and
the following figure is displayed. The student ID is watermarked on the
oscilloscope snapshot.

[(=|TestReport  j& Material

L) ¥ ® E E = E A - W - FontFamiy- FontSzes- B 7 - -
1 e5L RESUIL
ek Fun

v p

Figure 146: Scope snapshot inserted

6. Click Submit.
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7. Click Download to download the file and unzip it so that you can edit it in a
word document, as shown in the following figure.

. dditional files 4/20/2016 11:54 AM _ File folder
| £] Rise and fall time bt IY;

Open

Open in Same Window

Print

7-Zip 3

Open with » @ Google Chrome
@

, | & Intemet Explorer

[ Word (desktop)

Send to
B cut
A Cow D

Create shortcut

Choose default program..

Delete

Rename

Figure 147: Open the test report on the computer

For the instructor to query and check the test report:

1. Click Test Report on lower right side of the home page to check student’s
test reports.

2. Input the time next to Start and Stop and click Query to get the students’
report, the following figure is displayed.

Test Report

[Thursdey, April 21, 2016

siart siop
Instructor Course

Exercise Bench NO.
Student Name Student ID Query

Scope tutorial

Scope tutorial

Scope tutorial

Scope tutorial

Scope tutorial

Scope tutorial

Scope tutorial

Scope tutorial

Scope tutorial

Scope tutorial

Scope tutorial

Scope tutorial

Tektronix Scope tutorial
Tektronix Scope tutorial
Tektronix Scope tutorial
8 | Tektronix Scope tutorial

Rise and fall time

Rise and fall time measurem... |6

Rise and fall time measurem.
Rise and fall time measurem
Rise and fall time measurem
Rise and fall time measurem.
Rise and fall time
Rise and fall time
Rise and fall time-
Rise and fall time
Rise and fall time measurem.
Rise and fall time measurem.
Rise and fall time measurem

Detail

Figure 148: Query and check test report

Export Report List

Jacky
Jerry
Marry
Jessie Chang
Mike Edwald
Wang Tian
Tina Tang
Gary Wee
Chelsa Tang
Marry Ying
Patrick Ma
Bryce Li
Richeal CHEN
Jacky Wang
Tony Wu
Harry Ji

Export Report Files Delete

3. Double-click a report created by the student, or choose a report and click

Detail to check it.

4. Click Export Report List to export the query result to an Excel document.

o

Click Export Report Files to export all the text reports.

6. Select the report and click Delete to delete the report.
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Troubleshooting

Previous Software Version Installed

If the previous version of TSL3000B is uninstalled, but you can't install the new one, take
the following steps:

1. Uninstall the previous version and restart the computer.
2. Find the TekSmartLab folder in C drive.
o For 64 bit, the directory is C:\Program Files
(x86)\Tektronix\TekSmartLab
o For 32 bit, the directory is C:\Program Files\Tektronix\TekSmartLab\
3. Copy the folder to another directory, and then delete the folder.
4. Install the latest version of TekSmartLab software.

NOTE: Make sure that you copy and back up the data before you delete the folder.

If you need to restore the data of previous version, please contact your dealer or Tektronix
sales representative. They will contact engineers from the production line to assist you to
restore your previous data.

Software Can’t be Displayed Properly

After you open the software, the screen page can't be displayed properly, as shown in the
following figure.

Tektronix Teksmerilop'  Home Setting Administrator Abot

TekSmartLab

Report Template

160 Total Insf nts

Bench 40 Normal

9: Screen page not displayed properly

Figure 1
There could be two reasons for this problem:

e Screen resolution: If the screen resolution is lower than 1366*768, the software
screen page can't be displayed properly.
e Fontis not the right size.
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To modify the screen resolution:

1. Right-click on desktop and select Screen resolution.
2. Set the resolution to 1366768, as shown in the following figure.

Change the appearance of your displays

[ Detear
o
Display: 1 Mobile PC Display ~
1366 768 frecommenided)  +
q

ah it on the screen.

[ | 1366 x 768 (recommended)

| a0 ¢ 500

ok ] [ Cancel ] [ ameiy

Figure 150: Set the screen resolution
3. Click Apply.

To modify the font size:

1. Right-click on desktop and select Personalize.
2. Select Display, the following figure is displayed.

B » Contral Panel b All Control Panel ltems » Display | & § Search

Contral Panel Home

Make it easier to read what's on your screen

You can change the size of text and other items on your screen by cheasing ane of these options. To
temporarily enlarge just part of the screen, use the Magnifier tool

Smallr - 100% defaut) Preview
Change display settings

Cannectto a projector

@ Medium - 125%
Adjust ClearType text =
Set custom text size (DFD

ioose this setting while your display is set

Personalization

Devices and Printers

Figure 151: Set the font size

3. Choose Small-100% (default).
4. Click Apply.
5. Log off to complete the modification.
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TBX3000A Configuration Page can’t be Logged in

Take the following steps to solve this problem:

1. Restart the TBX3000A and the computer used to configure TBX3000A.
2. Check the LAN configuration of the computer to see whether it has the correct IP

address and gateway.
3. Check whether the TBX3000A is properly connected to the computer by the LAN

cable.
4. Check the LAN indicator of the TBX3000A to see whether it works properly.

For steps 2 to 4, please refer to Log onto the TBX3000A Configuration Page for more
information.

5. Ifall above steps fail, try a different web browser or change the computer.
6. You can also try press the RESET button for 5 seconds on the TBX3000A to
reset it to factory default, and then configure it again.
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Benches Disconnected

In the TekSmartLab WIFI network, the TBX3000A is configured, but all the benches are
displayed as disconnected on the screen page of TekSmartLab software. Below is an
example showing that all benches are disconnected.

1 2

3
SCOPE AFG | DMM  SCOPE AFG | DMM  SCOPE AFG
PWS

24

SCOPE AFG | DMM
PWS

Figure 152: All the benches not connected
Take the following steps:

1. Host Name of TBX3000A must be changed on LAN configuration page. If it is
changed on the WIFI configuration page, press Reset button on the TBX3000A 5
seconds to load its default setup and configure it again.

2. Check whether the Host Name of the TBX3000A connected to a certain bench,
such as Bench1 is correct. The host name must be in the form of BenchX; in
which X means number of the bench.

3. Check whether the WIFI indicator of the TBX3000A blinks twice at a time to see
whether it is connected to the WIFI network. If the TBX3000A is not correctly
configured, please refer to Configure the TBX3000A to configure it again.

4. Check whether the firmware of the TBX3000A is the latest version, which is
V2.0.0 or above. If not, please visit www.tek.com and search using the search
phrase “TBX3000A firmware”. Then download the latest version and upgrade the
firmware.

5. Check whether the server is connected to the network before open the software.

NOTE: Make sure that the server is connected to the network before you open the
software.

6. Check the TSL3000B version on the lab server. It should be V3.0.0 or above. If
not, please search and download the latest version from www.tek.com.
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7. Onthe lab server, ping the IP address of the TBX3000A on a certain bench, as
shown in the following figure. You can get the TBX3000A IP address from the
router configuration list. If this does not work, check the network configuration.

Pinging 192.168.1.151 with 32 hytes of data:

Reply from 192.168.1.151: bytes=32 time=105ms TTL=64
Reply from 192.168.1.151: bytes=32 time=41ms TTL=64
Reply from 192.168.1.151: bytes=32 time=5%9ms TTL=64
Reply from 192.168.1.151: bytes=32 time=12ms TTL=64

Ping statistics for 192.168.1.151:

Packets: Sent = 4, Received = 4, Lost = 8@ (Bx loss).
Approximate round trip times in milli-seconds:

Minimum = 12ms, Maximum = 185ms, Average = 54ms

Figure 153: Ping TBX3000A IP address

Unstable Connection in a 15-bench or above WIFI Network

TekSmartLab User Manual

In a WIFI network of 15 benches or above, the connections of the benches are quite
unstable, even though all the devices in the network are properly configured with the
latest firmware.

This problem is mainly caused by the WIFI network configuration. Take the following
steps:

1. Check the network configuration. Using 30 benches in this example, it is highly
recommended the network is supported by 1 router + 2 APs. If it's only supported
by 1 router, it's possible that not all benches can be distributed with an IP
address.

2. Check the router and AP configuration on the router management page to make
sure that the router has enough IP resources. Set the number of the Max.
Associated clients larger than the number of devices that are connected to the
network. For example, if the network is connected to one lab server, 30 benches
through TBX3000A, and 30 smart phones, set the number of Max. Associated
clients to be greater than 61.

3. Check the IP address of the server to make sure that the server is properly
connected to the network. If the IP address of the server says 169.X.X.X, it
means it is not assigned with correct IP address. Check the configuration of the
router and APs. You can connect the server to another AP and assign a static IP
address to it.

4. On the lab server, ping the IP address of a known bench. If this does not work,
check the network configuration.

113



TekSmartLab™ TBX3000A, TSL3000B User Manual

Unstable Connection in a 20-bench LAN Network

In a LAN network of 20 benches, the connections of the benches are quite unstable, even
though all the devices in the network are properly configured.

This problem is mainly caused by the router configuration or the MAC address of the
TBX3000A.

For router Configuration:

1. Check the IP address of the server. Ifit’s not correctly assigned, configure it
again.

2. Check the configuration of the router and make sure that all the benches are
properly connected to the router.

3. Onthe lab server, ping the IP address of a certain bench. If this does not work,
check the network configuration.

For MAC address conflict;

4. If your TBX3000A is manufactured before May 2016, there might be an issue of
MAC conflict. Please contact Tektronix representative for instructions on how to
change the MAC address.

Instruments are Displayed Disconnected

On the screen page of the software, the bench is displayed as connected, but the
instruments are displayed as disconnected. However, the instruments are turned on and
connected to the TBX3000A through USB cable. Below is an example that TBX3000A on
bench 1 is online, but the instruments on bench 1 are displayed as disconnected.

Figure 154: Instruments on bench 1 displayed disconnect
Take the following steps:

1. Visit www.tek.com to check the specifications of TSL3000B to make sure the
instruments are supported by TekSmartLab software.

2. Check that the version of TSL3000B is the latest version V3.0.0 or above. If not,
please visit www.tek.com and search “TSL3000B". Then download the latest
version and update the software.

3. Check that the firmware of TBX3000A is the latest version V2.0.0 or above. If
not, please visit www.tek.com and search “TBX3000A firmware”. Then download
the latest version and upgrade the firmware.
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4. For AFG1000 and TBS1000B-EDU instruments, check that the firmware for your
instruments are the latest version. If not, visit www.tek.com to download the
latest version and upgrade them.

5. For oscilloscopes of the series TBS1000, TDS1000C, TDS2000C etc., check
whether their USB ports are set as computer mode, If not, press Utility-> Options
—> Rear USB port -> Computer, and then restart the instrument.

6. For DMM4000 series instruments, the RS232 port should be configured as
follows:

e Baud rate: 9600

Polarity : None

Data bit: 8 data bits

Flow control: None

End of life character: Carriage Return and Line Feed

Computer and terminal Mode: Computer

Instrument Parameters are not Displayed

On the screen page of the software, the bench and instruments are displayed as
connected, but the instrument parameters are not displayed or an error message appears
when you enter the instrument page.

This problem is mainly caused by the firmware of the TBX3000A or other connected
instruments. Or the connected instruments are not supported.

Take the following steps:

1. Check that the firmware of the TBX3000A is the latest version V2.0.0 or above. If
not, please visit www.tek.com and search using the seach phrase “TBX3000A
firmware”. Then download the latest version and upgrade the firmware.

2. For AFG1000 and TBS1000B-EDU instruments, check the the instrument
firmware is the latest version. If not, visit www.tek.com to download the latest
version and upgrade the instruments.

3. Upgrade the firmware of the bench instruments to the latest versions, which are
available on www.tek.com.

4. Check the TSL3000B datasheet, to see whether the instruments are supported.

Students Can’t Log in Bench Webpage

The students can't log in the bench webpage either through bench computer or smart
device.

This fault can be caused by two reasons:

o IS configuration on the server.
o Network configuration of the bench computer or smart device
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For IIS configuration, take the following steps:

1. On the server with the TSL3000B running, open a web browser and input the
address of “localhost”. If the IIS is properly configured, a “please input bench

number” dialog box will be popped up and the following figure will be displayed.
¢ - CEr— —1

File Edit View F

Telitronix:

Lab Name: TekSmartLab

Bench:

Course Name: Scope tutorial

Exersise: Rise and fall time measurement
Student Name:

Student ID:

[C’Remember me
Scope Snapshot

Figure 155: Localhost webpage

2. Ifthe IIS is not properly configured, please refer to /IS Installation and
Configuration to check every step of the configuration.

If the following error message appears when configuring the IIS, then the 80 port conflict
is the fault.

Internet Information Services (IIS) Manager Iﬁ

I.-"'_"‘-.I This Web site cannot be started, Another Web site may be using the
‘S same port.

Figure 156: 80 port conflict
Use these steps to clear the fault:

1. Start Windows Task Manager (Ctrl+Alt+Del) to find which program is using port
80.
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2. Choose View -> Select Columns. The following figure is displayed.

8 Windows Task Manager = @ %

File Options View

Help

Applications | Proc

s | services | Performance | Networking | Users |

Image

Select Process Page Columns

Search
Searchls
Searcht

services|
Skype.ef
SkypeC:
SkypeC:
smss.e3

spoolsv.

Select the columns that wil apper on the Process page of Task Manager.

i P (Process Identifier),
(V] Usi &

CPU Usage
[ cPuTme
[C] memory - working Set

[C] memory -Paged Paal

[ Memory - Non-paged Pool

[ Page Faults

7] Page Fault Delta

[ Base Priority =

4
P

Proc

106

CPU Usage: 5% Physical Memory: 51%

Figure 157: Window task manager

o ok w

Select PID (process Identifier ).

Click OK.

Click Processes to display the programs with PID information.
Under Start >> All Programs >>Accessories, right-click Command Prompt and

select Run as administrator.

Input command “netstat -nao” and press enter to finish. (Note the space between

netstat and -nao)
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8. Identify the PID that is using port 80 (refer to Local Address as below) , and find
the program name in Task Manager. Itis “Skype.exe” in the example below.

=" Command Prompt 1 m

Microsoft Windows [Uersion 6.1.76811
Cnpyright_ _(c) 2808% Microsoft Corporation. All rights reserved.

Ui netstat —nao
Active Connections
- Lucai hddres's ) Foreign Address State
88 a.a.0 LISTENING

LISTENING
LISTENING

. 8

B

a

a

a

a

8 File Options View Help

a

g Applications | Processes | Services | Performance | Networking | Users

a

=

g Image Mame PID User Name CPU  Memory (1. %

g SearchIndexer.exe 5276 SYSTEM 00 8,760 K

] services.exe 620 SYSTEM 00 4,884K

a Skype.exe 7328 byani o0 98,968 K.

a SkypeC2CAutoUpdateSve.exe 2168 SYSTEM o0 990 K
SkypeC2CPNRSvC.exe 2255 NETWO. .. oo 1,216 K
SMSS.EXE 3% SYSTEM 0o 300K
spoolsy, exe 700 SYSTEM a0 3,516 K
SppsvC.exe 3980 NETWO... oo 1,040K
sglservr.exe 2592 NETWO... 00 28,732K
sqglwriter.exe 3272 SYSTEM [} 1,328K

Figure 158: Command prompt

9. Uninstall the program that is using port 80 or change the port the program is
using. The following figure shows an example of changing the port that Skype

') Skype™ - Options o

B Genem Connection: St up how Skype connects to the mternet
B Frivec Use port |_tocsncoming connedtians

[Tl use part 83 and 443 for additionslincoming conmections
i

Autamatic prowy detection =
-
Qo s Ersable proxy authentication

¥ Erable uPr?
& oanc

Alaw direct cannections o your contacts oriy L2 ]

i

Other things you gan d

Save Cancel

uses.

Figure 159: Changing port for Skype

10. Choose Tools -> Options-> Advanced -> Connection.
11. Unselect “Use port 80 and 443 for additional incoming connections”
12. Click Save to finish.
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For network configuration of the bench computer or smart device, use these steps:

1.

2.
3.

Check that the bench computer or smart device is connected to the same
network that the lab server is connected to.

Make sure that the server |P address is static.

Make sure that the IP address input in the TSL3000B general information page is
correct, so that the computer and smart device input the correct one to be
connected to the server.

If it still does not work, switch to another web browser.

The student can try to ping the server IP. If it does not work, check the network
configuration again.
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